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Introduction to Celestia 
 

Many of us have looked up at the stars on a dark night and wondered what it would be like to launch ourselves 
into space and soar among the stars.  What do the astronauts of the Space Shuttle really see when they look down 
upon our beautiful Earth turning slowly below?  What wonders might we encounter if we could visit Saturn 
alongside the Cassini spacecraft and sail right through its rings?  If you have ever wondered about these things 
and would like to find out the answers, we of the Celestia community are happy to introduce you to Celestia! 
 
Celestia is a free real-time space simulation that lets you visually experience our universe in three dimensions.  
Celestia was the initial inspiration and creation of Mr. Chris Laurel, a Seattle, WA computer programmer who in 
2001, decided to write a free software program to be made available to everyone on the world-wide-web that 
would place you in control of a virtual reality world of the Solar System.  His vision and dedication gave birth to a 
program that is unlike any other space simulation program in existence.  Celestia doesn't confine you to the 
surface of the Earth as many other programs do.  Instead, Chris created a dynamic capability to travel throughout 
the Solar System and anywhere else in space, at any speed, at any moment of time and in any direction you 
choose.  If you wish, you can fly via your own “hyperdrive” spacecraft to visit stars within the spiral arms of the 
Milky Way beyond the confines of our Sun.  You can even travel completely out of the Milky Way galaxy and 
view it from deep space. 
 
When Celestia version 1.0 first appeared available for download on the Internet, space enthusiasts all over the 
world discovered and quickly realized the potential of this beautiful program.  Within a year, many talented 
people worldwide joined Chris in a collaborative volunteer effort to make Celestia into not only a good graphical 
space simulation but into a great one, capable of producing a meticulously accurate virtual world of space rivaling 
the visual quality seen only in Hollywood films.   
 
They have succeeded.  As of this writing, over 1600 members of the public are part of the Celestia forum 
community.  Over 2.2 million people have downloaded the program for use at home or school.  The list grows 
daily and includes talented graphic artists, computer programmers, astronomers, astrophysicists, planetarium 
directors, animators, engineers, teachers, students, professionals from scores of occupations and ordinary citizens 
in over 25 countries around the world.  We invite you to join the Celestia forum at 
http://www.shatters.net/forum/profile.php?mode=register. 
 
Celestia is available free of charge for Windows, Linux, and Mac OS X from 
http://www.shatters.net/celestia/download.html.  Hopefully, you’ve already downloaded Celestia and are ready to 
install it and experience the beauty of space.  Here is just a taste of what you will be able to encounter: 
 
� Hover over each of the nine planets in our Solar System as they rotate slowly below you.  See clouds 

actually drift by (where applicable).  Look carefully and you may see mountains, canyons and craters on 
the planet surfaces with shadows being cast by them as the Sun sets low on the horizon.   

� Take a spin down to the Earth’s surface at a lazy speed or at thousands of miles/km per hour in your own 
spacecraft.  Skim over the oceans of Earth as you actually fly below the clouds.  See the sky turn a pale 
blue and eventually, transform into the crimson color of a sunset.  Soar back into space in time to see the 
lights come on in the cities of Earth and glow an eerie white as the dark side of Earth turns below you. 

� Position yourself above the giant gas world of Jupiter and watch as its large moons drift across the face of 
the planet, casting eclipse shadows on its banded clouds and Great Red Spot.   

� Hover far beyond Saturn, speed up time and count its many moons revolving around its magnificent 
ringed body like pearls swirling on an invisible necklace.  Watch as one moon eclipses another. 

� Follow along with the spacecraft Cassini as it makes a dramatic rendezvous with Saturn in 2004.  Be 
there to see the Huygens probe detach from Cassini and drop down to mysterious Titan in January 2005. 

http://www.shatters.net/forum/profile.php?mode=register
http://www.shatters.net/celestia/download.html
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� Journey to the frozen wasteland of Pluto and its moon Charon and imagine their icy coldness as the Sun’s 
faint light casts pale shadows across their cratered ice surfaces.   

� Take up station behind the comet Halley, set Celestia’s clock back in time and follow this famous comet 
on a trip into the inner Solar System, sailing past Earth with its gaseous blue tail streaming out behind it. 

� Visit the mysterious new world of Sedna, a lonely comet/asteroid large enough to be a planet, recently 
discovered orbiting the Sun far beyond Pluto.   

� Set your spacecraft speed and journey from the Earth’s surface up to the International Space Station or the 
Hubble Space Telescope.  Test your skill rendezvousing with them as they orbit Earth every 90 minutes. 

� Fly out to the very edges of our Solar System, locate and follow behind Voyager 1 and 2 as they speed 
farther and farther away from their creators back on Earth, headed on a one way journey through the 
blackness of frigid space toward distant stars that will take them millions of years to reach. 

� Set your ship at faster-than-light speed and sail to Rigel Kentaurus A and B, located 4.3 light years from 
Earth.  See if you can find their tiny red dwarf companion Proxima Centauri, the closest star to our own 
Sun, or choose to observe rotating sunspots on any of a whopping 2,000,000 other stars drawn by your 
computer in the Celestia universe (to see all of those stars, a separate add-on is required). 

� Download some of the many stunning add-ons available for Celestia and your experience becomes filled 
with even more wonders.  Visit the Discovery, a spaceship from the film “2001, a Space Odyssey”, dark, 
abandoned and adrift somewhere in Jupiter space with the HAL computer inside.   

� Journey to the edges of a massive rotating Black Hole as it spins near its stellar companion. 

� Journey to Earth’s future and be witness to the end of our planet as a swollen Red Giant sun consumes it. 

� Witness a pulsar imbedded deep in the Crab Nebula spinning rapidly as it sends its twin beacons of light 
through the nebula gas. 

� Travel back in time to witness a re-creation of what the Earth looked like billions of years ago.  Be there 
as Orpheus, a planet the size of Mars crashes into it, creating our Moon and sending it into an orbit within 
a few thousand miles of Earth.   

� Travel forward to the year 2800 CE to observe giant mirrors melt the Martian polar ice caps and help to 
terraform the planet into a verdant world of water, plants and cities of the future. 

� Drop “up” to the massive rotating Space Station V from the film, “2001 a Space Odyssey” in the year 
2400 CE and see if you can land your “Celestia 1” spaceship in its cavernous landing bay. 

� Time travel to the future and witness a massive “Space Elevator” connected by cable to the Earth 
thousands of km below. 

� Visit exotic fictional solar systems, complete with orbiting mining colonies, wormhole portals in space, 
and scores of planets, moons and spacecraft.  We even have a Dysen Sphere for your viewing pleasure. 

� Are you a Star Wars fan?  The Celestia community has made available for download an entire Star Wars 
solar system.  Orbit the planet Tatooine and you will be amazed at the realism of its arid deserts.  Fly via 
hyperjump over the ice world, Hoth or to the green world of Endor but be careful for tractor beams.  
Somewhere in that solar system will be the giant imperial Deathstar, glinting as the light from the 
system’s yellow Sun actually reflects off its evil metallic skin as a huge Star Destroyer and imperial tie 
fighters keep guard.  

� Approach an entire fleet of Borg Cubes as you command the USS Enterprise E from the StarTrek series. 

These are just a few of Celestia’s features.  Each week, new features are being added by Celestia’s programmers 
and other talented contributors.  It is a program undergoing a rapid evolution in computer graphics.  Add-on 
features, for example, will include entirely new solar systems with dozens of planets and moons drawn in vivid 
detail, gaseous nebula clouds, new galaxies, stars, globular clusters and spacecraft both real and imaginary.  
Periodically as new features are added, this User’s Guide will also be revised.  If this list above excites you, let’s 
get started on our journey into the heart of Celestia. 
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 Night Sky Demo 
 

Celestia is a stunning program to observe and explore the Solar System and beyond.  To help you discover some 
of its beauty and secrets, Celestia has a short journey already laid out for you.  To see it, launch the program as 
described below, pull down the Help Menu and select Run Demo.  When done, press the [Esc] key.   
 

NEW -  Scripts and Educational Journeys 
 

Celestia developers have created a score of other detailed scripted journeys that take you as an observer to a 
variety of fascinating places.  To access and download them, visit Celestia’s “add-on” repository website at 
http://www.celestiamotherlode.net/index.html and click on the link for “Scripts”.  Download the script of your 
choice and place it in the Celestia main folder, which will be usually located on your C:/ drive, in your Program 
Files directory.  You can then launch it from within Celestia (see later instructions).    
 
The ability of Celestia to educate the public about Astronomy and space has also led to the development of a 
series of detailed Educational Activities that take Celestia users on a series of detailed virtual tours of the 
universe.  Designed for all general audiences and for students in 7th – 12th grades, these Activities teach you a host 
of facts about specific astronomical topics, while employing the stunning power of Celestia to take you there 
visually.  They even come with student worksheets that can be printed, copied and distributed by teachers to 
students for a grade, and meet all National Educational Standards in Science.  To access them, go to 
http://www.celestiamotherlode.net/index.html and click on the link for “Educational”. 
   
 

Program download and add-ons 
 

Celestia is a computer program written in the computer language C++.  The code is Open Source, and may be 
examined and modified by anyone under the terms of the GNU Public License.  For experienced programmers 
who have an interest in improving the program, you can find the Celestia source code at 
http://www.SourceForge.net.  Click this link:  Celestia. 
 
In addition to the actual program, Celestia can include many other add-on files (graphics and data) that the 
program can use.  If you choose to download the entire library of over 500 Celestia add-ons designed to date by 
its many contributors, they can take up over 4 GB (gigabytes) of disc space.  For many people with limited 
computer memory and/or internet download speed, that is very large.  To offer Celestia in a reasonable fashion, 
therefore, the basic default program is provided for download with a comprehensive but limited set of files, 
sufficient to experience its capabilities without overtaxing your computer.  “Links” (web addresses) to guide you 
to the additional add-on files available are listed on the web within the User’s forum and the Celestia website.  To 
fully experience what Celestia has to offer, we urge you to seek out and download some of these other add-on 
files.  At one time, the add-ons were spread out across over 60+ websites.  Fortunately, volunteers have been 
assembling a central repository for them.  It is not complete, but is growing rapidly.  Its web address is:  
http://www.celestiamotherlode.net/ and should be your first stop for add-ons. 
 
Another site with over 100 of the add-ons compiled can be found here:  http://celestia.myftp.org/?lang=en.  In 
addition, these sites all have add-ons to use:   
 
Jeam.tag's add-on site (In French, but all links work)
Praesepe's Files     Texture Foundry
Mike’s add-on list    BT’s Celestia add-ons
Celestia basic textures    Don’s Celestia Central
Selden’s Resources    NASA's Celestia add-on files

http://www.celestiamotherlode.net/index.html
http://www.celestiamotherlode.net/index.html
http://sourceforge.net/projects/celestia/
http://www.celestiamotherlode.net/
http://celestia.myftp.org/?lang=en
http://jeam.tag.free.fr/CELESTIAhtml/Celestia-Addons.htm
http://www.shatters.net/~praesepe/files/
http://www.shatters.net/~t00fri/texfoundry.php4
http://mikecelestia.bravehost.com/downloadlist.htm
http://www.bt.homepage.btinternet.co.uk/Celestia.htm
http://cvs.sourceforge.net/cgi-bin/viewcvs.cgi/celestia/celestia/textures/
http://www.shatters.net/~impulse/Hub/Celestia_Hub.html
http://www.lns.cornell.edu/~seb/celestia/index.html
http://exp.arc.nasa.gov/downloads/celestia/extras/
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Celestial Visions    Frank’s Educational Activities     
Jack’s spacecraft add-ons   Jim’s Celestia page
Maxim’s site     Bob Hegwood’s site
John’s Download site     
     
     
 Please note that the above links may be temporary.  Websites come and go based on member’s arrangements 
with hosting servers.  However, the above sites are an excellent start.  If I left out someone’s add-on website, 
please forgive me.  Remember that there are over 100 such sites scattered throughout the forum.  To see links to 
more of them, visit and browse the forum at http://shatters.net/forum/index.php.   
 
The Celestia default program and package for computers running Microsoft Windows® 95, 98, ME, 2000, XP, or 
NT 4.0 is offered as a fully “executable” program.  It will install itself into your computer.  The current Windows 
version is 11.6 megabytes in size and is called Celestia-win32-1.3.2.exe.  It is available for download at 
http://www.shatters.net/celestia/download.html.  If you have a computer that is less than 2 years old, this is the 
only file you will need to get started.  If you have an older computer, or one with a graphics card with less than 32 
megabytes (MB) of memory (see below), the Celestia package with low-resolution textures is only 4.5 MB in 
size and may run better on your system.  You can find it at the same website above.  Please note that you do not 
need both of them.  See hardware comments in the next section below for more detail. 
 
Celestia is also available to Apple Macintosh users running Mac OS X (Celestia version 1.3.1).  The comments 
mentioned above for Windows also apply to the Apple version of Celestia.  You can find the MAC version at 
http://prdownloads.sourceforge.net/celestia/celestia-osx-1.3.1-1.dmg.   
 
Celestia version 1.3.2 is available for Linux in two different versions (Mandrake and SUSE8) in a single tarred, 
gzipped source archive at http://www.shatters.net/celestia/download.html.  Which version you choose to install 
depends upon which desktop environment you have installed.  The most polished version of Celestia for Linux 
requires KDE3 (Celestia is not compatible with earlier versions of KDE.)  If you do have KDE3, it’s highly 
recommended that you choose the KDE version of Celestia, as it’s under the most active development.  Celestia 
can also be compiled to use Gnome/Gtk, although Gnome interface is not up to par with KDE and Windows UI.  
It’s still possible to build Celestia even if you don’t have either KDE3 or Gnome.   
 
Required Libraries: 
All versions of Celestia for Linux require that you have OpenGL installed.  More and more distributions are 
shipping with OpenGL, so if you’ve recently installed or re-installed Linux, there’s a good chance that you 
already have a working OpenGL configuration.  In order to build Celestia, you need to have the OpenGL 
developers packages installed.  They should be available on your distribution CD or ftp site if they’re not already 
installed.  After you’ve successfully built Celestia, you will want to be able to run it with hardware 3D 
acceleration.  For this, you’ll need a Linux OpenGL driver from your graphics chipset maker.  If it’s not already 
installed, you’ll have to download it from the chipset maker’s web site.  NVIDIA and ATI are the two largest 
graphics hardware makers, and both offer Linux drivers in the drivers section of their web sites.  Celestia requires 
the image format libraries libjpeg and libpng; both should be present on all up to date Linux installations.  In order 
to build the Gnome/Gtk version of Celestia, the gtkglarea library is necessary.  It is available at 
http://www.student.oulu.fi/~jlof/gtkglarea/ if not already installed on your computer. 
 
 

Computer Hardware Requirements 
 

Celestia is a sophisticated program that not only positions and graphically depicts our complete Solar System in 
3D; it also plots and tracks a sky full of hundreds of thousands (to millions) of stars in real time.  This takes 
computer power and computer memory.  Celestia also has available hundreds of add-on files.  Some of them are 

http://www.celestialvisions.net/
http://www.fsgregs.org/celestia/
http://homepage.eircom.net/~jackcelestia/
http://home.arcor.de/jimpage/
http://www.nefkom.net/z-bau/celestia/
http://home.earthlink.net/~bobhegwood/index.html
http://johnscelestiapage.no-ip.com/filemgmt/index.php
http://shatters.net/forum/index.php
http://www.shatters.net/celestia/download.html
http://prdownloads.sourceforge.net/celestia/celestia-osx-1.3.1-1.dmg
http://www.shatters.net/celestia/download.html
http://www.student.oulu.fi/~jlof/gtkglarea/


Celestia User’s Guide              7 of 40 

large model and graphics files that require lots of RAM memory.  Thus, identifying what level of computer 
performance you need to enjoy the program depends upon what level of detail you wish to achieve. 
 
In general, to run the basic Celestia program, your computer should have a CPU (processor) that has a speed of at 
least 800 million cycles per second (800 MHz).  Typically, computers bought new within the last 2 years have 
adequate CPU speeds.  If your computer is more than 2 years old or is a Pentium III or equivalent with a 
processor speed slower than 800 MHz, Celestia may run slowly and you will be disappointed.  
 
The basic Celestia program also requires a minimum of 128 megabytes of RAM memory.  The graphics files that 
Celestia use are large, and if your computer does not have at least 128 MB of RAM, Celestia may run very 
slowly, not run at all or may lock up.  In addition, if you wish to explore Celestia’s maximum capabilities, you 
will need up to 512 MB of RAM.   
 
Most importantly, the program has become very sophisticated and its many members have added gigabytes of 
textures and files to it.  As a result, Celestia now really needs a 3D video graphics accelerator in your computer.  
This is hardware circuitry that draws complex graphic images on your video display monitor.  Graphics cards are 
available for purchase at any computer/electronics store and are easy to install.  They retail for between $100 and 
$200, and will dramatically improve your computer’s performance in any graphics intensive application.  Celestia 
should run with any 3D accelerator card with at least 32 megabytes of video memory.  However, a 64 MB to 128 
MB Video RAM card is required if you intend to use Celestia’s more detailed graphic files, and for the biggest 
add-ons, 256 MB of graphics memory is desirable.  If you have such a card, Celestia will run smoothly and its 
graphics will be complete, crisp and sharp.  If is runs too slowly, is blurry, locks up, or objects appear to be 
moving with jerky motions, you may need to locate a faster computer or one with more memory or graphics 
capability.  
 
** PLEASE READ CAREFULLY:  Celestia uses the OpenGL API to render 3D graphics.  In order to get the 
most from Celestia, you should have a modern OpenGL graphics card with the latest drivers from the 
manufacturer.  If you have problems running Celestia, verify that your graphics card is capable enough to run 
Celestia, and that the drivers are up to date.  If in doubt about the OpenGL driver, download and install a new 
one.  It will be available free from your card maker’s web site. 
 
Please Note:  While a graphic video card might use Open GL processing, Celestia does not run well on all such 
card brands or models.  Several graphic cards handle images in a manner that Celestia may not control properly.  
To date, Celestia’s features work best on the video chipsets manufactured by NVIDIA, Inc.  Those video cards 
sell under the model names “GeForce”, FX and “Quadro”.  If a compatible Open GL card is not present in your 
computer, Celestia can still offer you a beautiful space experience, but some of its advanced features may not 
display.  These include shadows on mountains and craters (bump mapping), sunlight reflections off water 
(specular highlights), shadows of moon eclipses, and atmospheric haze.      

 
As development of Celestia continues, better support for graphics hardware will continue to be introduced.  If not 
all the features of your graphics card are supported yet, be patient.  Better yet, join the Celestia development team 
and help improve the program.    
 
 

Installation and Uninstallation 
 

If you have a video card incorporating a graphics accelerator with at least 32 MB of memory, install the full 
Celestia installation (i.e. – celestia-win32-1.3.2.exe).  If your computer is an older model, does not have a 
graphics accelerator or does not support Open GL processing, obtain the Celestia package with low-resolution 
textures and install that.  The views you see in Celestia will be simpler and less detailed, but this version of the 
program and its files require less RAM and it may run more smoothly.  If you don’t know if you have a graphics 
accelerator card of not, download the full version and try running it.  If things do not run smoothly, you may not 
have such a card.  Also, see the Celestia website for additional troubleshooting, at 
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http://www.shatters.net/celestia/faq.html.  Alternatively, the main Celestia package includes some low-resolution 
image files.  While running Celestia, you can switch from one resolution of graphics to another by tapping the 
[Shift+R] keys on the keyboard (for high resolution), or just the [R] key (to change to low resolution images).  
This may speed up your program.  Note, however, that not every image in Celestia is represented by both a high 
and low-resolution image.  If you tap the [R] or [Shift+R] keys and nothing happens, it just means there is no 
smaller or larger resolution image of that planet, moon, asteroid or spacecraft in your Celestia texture files to use.    
 
 
Windows Operating System (95, 98, ME, 2000, NT, XP): 
Once you have obtained and downloaded the executable file from the Celestia website, simply click twice 
(double-click) rapidly on its name with your left mouse button.  The file will begin running and will install 
Celestia in your C:/Program Files Directory.  In general, just click “Next” whenever it asks a question.  Celestia 
has its preferred choices and unless you have good reasons for altering them, we suggest you follow them. 
 
Macintosh OS X Operating Systems: 
To install the Macintosh version, click on the installation file and follow the on-screen menu instructions.   
NOTE – Celestia uses a special hyperlink file internally within the program called a .cel:url file.  When 
you click on a .cel:url, the program treats it as a kind of “address” and will respond by going to a 
particular place and time in the night sky.  It is similar to the way web browsers such as Internet 
Explorer and Netscape go to certain web pages when you click on a hyperlink address. 
 
In the Windows installation program, the install procedure automatically “registers” Celestia as the 
program that utilizes .cel:urls.  In the Apple MAC OS X operating system, however, registration of 
.cel:url file links as “belonging” to Celestia is not automatic.  You have to do it manually.  See your OP 
Help menu for how to register an “extension”.  If you do not do this, some aspects of Celestia will not 
work properly.  For example, if you click on a .cel:URL file without registering it, your web browser 
will launch instead and try to take you out onto the internet.  You will get a message saying “page not 
found”. 
 
Linux Operating Systems: 
RPM packages are provided for the SuSE and Mandrake distribution. You can get them from the SourceForge 
project page.   If you run SuSE or Mandrake the preferred way to install Celestia is to get the celestia-kde and 
celestia-kde-texture packages for your distribution and to install them by running as root in the directory where 
the files have been downloaded: 
rpm -Uvh celestia-kde*  
Alternatively, or if you don't run one of the supported distribution, you can compile Celestia yourself. Unpack it 
and its libraries with gzip and tar via the command:  gzip -dc celestia-1.3.0.tar.gz | tar xvf
Then change directory (cd) into the newly created directory and configure Celestia.  Run configure with the 
appropriate command line for the version that you want to compile: 
KDE

./configure -with-kde
Gnome/Gtk

./configure -with-gtk
GLUT

./configure
configure may complain if you are missing a required component, or if you have an out of date version of a 
required component. Check the error output from configure to determine what's missing, install the necessary 
items, and then try rerunning configure.  If neither the KDE or Gnome versions of Celestia will build, try falling 
back to the GLUT version. There are many options for configure; you can view them all-together with a brief 
explanation for each-by running ./configure -help.  After running configure, compile and install Celestia: 
make
make -install

http://www.shatters.net/celestia/faq.html
http://sourceforge.net/project/showfiles.php?group_id=21302
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Note:  make -install will need to be run as root unless you've overridden the default install directory by 
invoking configure with the -prefix option.  

Hopefully, compilation of Celestia will go smoothly.  If it does not, it's most likely because some required 
package is missing.  A relatively common problem is that the OpenGL developer package necessary for building 
OpenGL applications has not been installed.  If the compiler complains that gl.h or glu.h is not found, it's a 
symptom of a missing or improperly installed OpenGL developer package.  Once make completes without errors, 
you're ready to run Celestia from either your desktop of choice or the command line.  
 
 
Uninstall:   
To uninstall Celestia in Windows, click the Start button at the bottom left of your screen, select “Settings”, then 
select “Control Panel”, then select Add/Remove Programs.  Locate Celestia in the list that appears and click the 
button that says, “Add/Remove”.  For Apple, LINUX/UNIX owners, follow your system’s uninstall procedure. 
 

Note:  In the sections that follow, images and screenshots from the program will be 
displayed.  Many of these images use higher-resolution graphics that are not part of the 
default download program, but which are available from the Celestia forum and other 
websites as add-ons.  As a result, if your version of Celestia does not precisely match the 
enclosed screenshots, don’t be alarmed.  

 
Note:  In the following Guide, many keystroke commands will be referenced.  All 
keystrokes will be enclosed inside a square bracket [  ].   Since all of the letters on a 
modern keyboard are in capitals (e.g. – K or L or M), keystroke references will be in 
capitals also (e.g. – [ K ] means press the “K” key).  You do not have to use the [Shift] 
key.  On occasion, however, a keystroke will require the use of an actual capital letter, 
such as the capital letter “T”.  If that happens, we will instruct you to press both the 
[Shift] key and the [T] key.  For example, the instruction will read, “Press the [Shift+T] 
keys”.  If the keystroke is a symbol that requires the use of the [Shift] to reach such as a 
colon [:] or an asterisk [*], please press the [Shift] key at the same time as you press the 
symbol keystroke.  For example, to type the & sign, you would actually press [Shift] and 
the [ 7 ] key at the top of the keyboard, together at the same time.  Some keystrokes 
require the use of the [Ctrl] key or [Alt] key.  When they do, we will instruct you. 
 
 
 
 
IMPORTANT NOTE:  On occasion, we will instruct you to “Click here” to actually 
launch a scene in Celestia.  It is VERY important that you click that link ONLY ONCE.  
If you double click it, two separate versions of Celestia will launch.  Since the program 
uses a lot of memory and computer resources, two programs running at the same time 
will lock up your computer or slow things down dramatically.   
 

 
Note:  New features since the previous version of this Guide are highlighted in Red. 
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General Operation and Keyboard commands 
 

1) To launch Celestia, double-click on its icon on your desktop or single-click in the Programs menu that 
appears when you click your Start button.  The program will load (it can take up to 20 seconds to open) and 
will position you out in space.  The beauty of Celestia is its accuracy.  The image in front of you is exactly 
what you would see if you were really positioned in space at that very spot at that particular time.  In other 
words, Earth, Mars, and all of the planets, moons, stars and spacecraft visible on your screen really are located 
in space where Celestia has put them.   

The Opening Screen 
 
 
Figure 1- Earth 
 
If you wish, you may click here   
ONCE ONLY to go to Earth 
 
 
 
 
2) Earth turns on its axis constantly and is always changing position.  Thus, the screenshot above may or may 

not be the same scene you see when you open Celestia.  However, it will be similar. 
 
3) In the top left corner will be some information about your target (Earth) (if you see no text, press the [V] key 

once on your keyboard to turn on your text display).  “Distance” gives you the distance from the surface of 
the object to your viewpoint.  The Radius of the object will be listed in kilometers.  NEW – The Apparent 
Diameter will be a value in degrees representing the size of the object in front of you as seen from your 
current viewpoint.  If you move closer or farther away from the object, its apparent diameter will get larger or 
smaller respectively. 

4) In the lower left corner will be your Speed through space.  At the moment, your ship is stopped (relative to 
Earth) so your speed is zero.  Later, we will begin to fly on our own and your speed will be listed here.   

5) In the top right corner will be the current date and time.  In Astronomy, times are given in Universal Time 
(UTC) (commonly referred to as Greenwich Mean Time), and this is what Celestia uses by default.  If you 
find it more convenient, you can access the Time menu at the top of the program screen and check the box to 
make Celestia show your local time zone instead.  The date is listed in the format (year month day). Note that 
time will be in 24-hour format.  Thus, 1:00 PM will be 13:00:00 hours.  Celestia can also speed up or slow 
down time or travel forward or backward in time with the touch of a button.  Now, you are experiencing the 
program in “Real time”. 

6) In the lower right of the screen will be a message telling you that you are “Following” Earth.  Wherever it 
goes, you go.  Thus, although Earth is actually moving rapidly through space, you are moving with it.   

 
Field of View: 

 
7) Under the “Follow Earth” text will be your “Field of View” or “FOV” setting.  This is the amount of sky 

your view takes in.  Celestia starts you out with an FOV that it calculates, based upon your screen size, 
resolution and monitor settings.  It ranges from 15° to 45°, which means your monitor is displaying about 15° 
- 45° of the sky (most people have a total visual field of 120°).  However, you can change the FOV easily by 
holding down the [Shift] key on the keyboard, [left-clicking] your mouse button and dragging the mouse 
forward or backward.  Try it.  As the FOV gets smaller, the scene enlarges.  It is similar to a telescope 
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magnification.  You can also press the [ . ] key or the [ , ] keys to change field of view from the keyboard.  
Enlarging the FOV allows you to magnify objects in the distance, while still keeping the planet in the 
foreground.  In general, an FOV of about 32° presents a sky view that draws objects at about the size you see 
them in space.  If you wish to return to the default FOV that your program opened with, and you have a 
mouse wheel, click/push the [wheel button] down once.  Please note that if you change your screen window 
size by dragging its borders, Celestia may assign and change the FOV, based on the new screen size. 

8) You can also instruct Celestia to launch the program with a particular starting FOV, rather than sizing it based 
on your screen settings.  To do so, locate the file named “start.cel”, which is in the Celestia main Directory 
folder.  Right-click on it and choose the option that says, “open with”.  A list of programs on your computer 
will appear.  Locate a text editing program such as MS WordPad or Notepad and click OK.  The start.cel file 
will open and you’ll see a set of single line commands (in English).  Locate the line that says,  

# “set { name "FOV" value ____ }”.  Remove the # symbol and in the space, type 
whatever FOV value you wish.  For example: 

set { name "FOV" value 32.0 } produces a 32° field of view that is about what your eyes 
would see without a telescope if looking at the Moon or a particular spot in space.  

Save the file, close it and launch Celestia.  The program will now always start with an FOV of 32°. 

 
 Figure 2  - click here to visit    Figure 3 – click here to visit 

 

 

 

 

 

 

 
The FOV here is 45°.  Notice size of the moon behind Earth.     The FOV here is 12°.  Earth and moon are now enlarged. 

 
 

Set Program Options (Render menu) 
 

9) When you use Celestia for the first time, you will need to choose some options that will tell the program how 
you want things done. Celestia will remember these settings once you initially establish them.  However, 
during your subsequent use of Celestia, you may have need to change or reset these options.   

 
 
10) Display Mode:   To open the Render menu, [left-click] on the word “Render” at the top of the Celestia view 

screen and choose “Select Display Mode” or “Toggle Full Screen”.  These are instructions to Celestia to 
change the resolution of the view screen.  Choose the "Select Display Mode" menu first to choose the size of 
the viewscreen you prefer.  “Windowed Mode" is the default choice and sets your screen to the same 
resolution size your display monitor is set to display.  For example, most desktop computers display a default 
screen resolution of 800 x 600 pixels, while new Win XP systems and laptops are typically set to 1024 x 768 
pixels in either 16 or 32-bit color.  To find out what your computer display is set at, [right-click] on your 
desktop, choose “properties” and “settings”, and read the monitor resolution setting.  When running Celestia 
in Windowed Mode, your screen gives you visible screen borders, sliders and toolbars.  You can resize the 
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screen by dragging its corners, minimize the screen, switch between programs, etc.  If instead you select a 
different screen resolution from the Display Mode pulldown menu, Celestia will immediately switch to Full 
Screen Mode, and draw the screen in that pixel size, filling up the entire screen.  All of the toolbars, sliders 
and side borders will disappear.  High-end computers and those with up-to-date video cards can take 
advantage of tighter packed pixel sizes and more detailed appearance, and many users prefer to view Celestia 
in Full Screen Mode at smaller pixel sizes.  The screen is uncluttered and your view really looks like the 
window in a spacecraft.  For some space scenes, the view can be extraordinary.  However, there are 
disadvantages to Full Screen Mode.  First, in order to access the toolbars, you must point your mouse toward 
the top of the screen and wait for the menu/toolbar to be drawn.  With some video cards, the entire screen will 
go black for a moment as the toolbars are being drawn.  Secondly, some screen modes are simply not 
designed for certain monitors.  For example, if you set your resolution at 1280x720 on a regular CRT 
monitor, the screen will look warped and the planets will be ellipses, not spheres.  Also, be advised that the 
ability of Celestia to redraw complex scenes in different screen sizes varies from system to system.  Some 
users have reported lockups and program crashes when using Full Screen Mode at certain display sizes.  We 
recommend you experiment with your own system and choose the resolution that works best for you.  
[Alt+Enter] is a useful keyboard shortcut that toggles between 
Windowed Mode and Full screen.  

 
Note:  If you are in Full Screen Mode and wish to toggle between 
Celestia and another program, simply press the [Alt + Tab] keys 
together.    
 
 
11)  “View Options” is the 3rd option in the Render menu, and an 

important one.  Left-click this option to open the View 
Options dialog box.  A list of choices will appear.  Deciding 
which ones you want is a personal and a practical choice.  If 
your computer is a newer model, then we recommend the 
options listed in the image to the right of this paragraph, and 
described in detail below.  If your computer is slower or older 
and Celestia appears to be running slowly, deselect some of 
these options, as suggested in the following discussion: 
Note:  Keyboard shortcuts to these options are listed in brackets. 

 
 
Atmospheres  [Ctrl+A] is the keyboard shortcut to turn Atmospheres on or off (toggle) - Celestia will 

draw colored atmospheres above all planets and moons that have them.  You will be able to 
see them from space and even fly through them.  As you do, the sky will lighten.  
Atmospheres will even dim and turn color as you view them near the terminator (near the 
dark side).  Highly Recommended - but does require computer resources.  Try turning it off 
(uncheck the box) or toggle the key shortcut if Celestia is running too slowly on your system.  

 
 
 Figure 4 – Click here to visit            Figure 5- click here to visit 
 
 
 
 
 
 
 
 
 
 Earth with Atmospheres selected.        Same scene without Atmospheres selected 
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Celestial Grid [ ; ]  Celestia places an equatorial coordinate grid on the screen showing you the celestial 
position and direction you are facing in space.  The grid follows the standard convention of 
Right Ascension and Declination used in 
Astronomy.  Recommended – when needed to 
locate a direction in space.  For example, you 
can turn the grid on temporarily to identify 
direction of an object in Celestia then go to a 
real telescope and swing to that approximate 
coordinate.  You can also use the Celestial Grid 
to help you decide where to place a fictional 
add-on or to locate an object whose RA and 
DEC you know from another source. 
       Figure 6 - Sky with Celestial grid Enabled 

            Click here to visit  
 
 

Clouds [ I ]  Some of the planets in our Solar System and many fictional planets that Celestia users 
create in other solar systems have clouds drifting across their surfaces.  Celestia has the 
ability to display clouds and put them in motion.  Highly Recommended - but does require 
computer resources.  Try turning off if Celestia is running slowly or if you want clear skies.  

 
 Figure 7 – click here to visit    Figure 8- click here to visit 

 
 
 
 
 
 
 

 
 
 
 Earth with moving clouds selected.                Same scene without clouds selected 

 
 
 
Comet Tails [ Ctrl + T ]  Celestia will accurately place a 

gaseous comet tail behind all comets, properly 
oriented to always point away from the Sun.  
To see those tails, you have to be close enough 
to the comet.  Highly Recommended - but 
requires computer resources.  Try turning off 
if Celestia is running too slowly.     

 

Figure 9 -Venus and comet Ikaya-Zhang in Feb, 2002 
Click here to visit 
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Constellations Celestia will display both constellation borders [Ctrl + B] and their official “shapes” [ / ]  
for each of the 88 constellations in the sky.  In the second Options menu section, you can also 
turn on constellation labels [=].  These 3 options are useful whenever you have an interest in 
locating a particular constellation in Celestia.  Recommended – only when desired.  Does 
not use much computer resource.   

 
 
Figure 10 
 
Constellations with 
borders and labels 
enabled.  As viewed 
from Earth, the Sun 
is “in” Capricorn.   
 
Click here to visit. 
 
 
 
 
 
 
Eclipse Shadows [ Ctrl + E ]  Celestia can compute the actual position of the shadows a moon or planet will 

cast on a planet/moon as the object passes in front of the Sun (a solar eclipse).  Turning this 
feature on will cause shadows to be drawn on all planets/moons whenever an eclipse occurs.  
It is an elegant feature, particularly when observing moon shadows drifting across the giant 
gas worlds of Jupiter and Saturn.  Highly Recommended - but does require significant 
computer resources.  Note:  On older video cards, eclipse shadows may lock up the program.   

 
 Figure 11 – click here to visit    Figure 12 – click here to visit 
 
 
 
 
 
 
 
 
 
 
 
 
 Io eclipsing Jupiter, an example of Eclipse Shadows.            A total solar eclipse over Africa, as seen from space 
 
 
 
Galaxies [ U ]  Celestia comes with a galaxy data file that tells the program the position of several 

galaxies in the night sky and what type they are.  When this option is selected, Celestia will 
create a small, dim sketch of each galaxy and position it in the proper place in space.  It will 
also draw the huge band of starry haze we know as the Milky Way.  Selecting the option, 
therefore, will improve your Celestia experience and you will be able to see the Milky Way 
across the sky and dim galaxies in the distance.  You can even travel to them in your 
spaceship.  However, the galaxy sketches are simple and appear as dim “blobs”.  Later 
versions of Celestia will improve on the graphics of galaxies.   
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NEW - The Galaxy option also turns on or turns off nebula.  Nebula add-ons such as the 
famous Orion Nebula or the Rosette Nebula are very popular in Celestia, but drawing them 
can really tax your computer system.  If you have too many of them positioned in the sky, 
your system will slow down.  Recommended - but does require computer resources.  Try 
turning off if Celestia is running too slowly. 
 
 

 Figure 13 – click here to visit    Figure 14 – click here to visit 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Neptune and Milky Way with Galaxies enabled.      Same scene without Galaxies enabled 

 
 
 
Night Side Lights [ Ctrl + L ] Celestia has the ability to light up the night sky.  From space, the thousands of 

cities across our continents are ablaze with light so bright that they can be seen vividly from 
hundreds of km up.  Turning on this option commands Celestia to add those lights to the 
nighttime vista you see from space above Earth.  Night textures are also used in some add-ons 
to show fictional cities or volcanic lava flows at night.  Highly Recommended - but does 
require computer resources.  Note:  On older video cards, night-side lights may slow down or 
lock up the program.  Try turning off if Celestia is running too slowly.  

 
 Figure 15 = click here to visit    Figure 16 – click here to visit 

 
 
 
 
 
 
 
 
 
 
 
 
      Earth, Sun and terminator with night-lights enabled     Same scene without night-lights enabled 
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Orbits [ O ]  Celestia will draw the actual path of a space object’s orbit through the solar system.  
The Option draws orbits of all planets, moons, comets, asteroids and spacecraft that you 
choose.  Each orbit type is drawn in a different color, with the active orbits in red.  For 
example, if you are centered on Venus and have “planet” orbits selected, Venus’s orbit will 
be highlighted in red.  All other planet orbits will be highlighted in blue.  Orbits are excellent 
for seeing the celestial mechanics of the solar system.  Turn them on, zoom out from the Sun 
or planet and view the orbits from above.  Speed up time (see later discussion) and you will 
see the alignment of planets speeding around the Sun, or view the orbits of satellites as they 
circle around a planet.  The Orbit/Label section of the View Options Menu allows you to 
turn specific orbit types on or off with a check mark in the box.   
Recommended – when desired.   Does not use much computer resources.   

 
 
 
 
Figure 17 -  click here to visit 
 
Solar System with planet  
orbits enabled and time 
speeded up.  The inclined orbit 
is that of Pluto, a large Kuiper 
Belt Object that may have 
swung into its current orbit 
through a past collision with 
another object. 
 
 
 
 
 
Planets Displays all planets as full color detailed textures.  Most are based on accurate satellite photos 

of the planets.  Normally selected (no keyboard shortcut).  Highly Recommended.   
 
 
 
Ring Shadows (no keyboard shortcut) - Celestia can compute and continually redraw the actual position of 

the shadows a planet’s ring will cast on a planet below and conversely, the shadow a planet 
will cast on its rings.  Highly Recommended - but does require significant computer 
resources.  Note:  On some older video cards, ring shadows can slow down the program 
dramatically or lock it up entirely.  Deselect if your computer is running too slowly. 

 
 
Figure 18 – Ring Shadows enabled – click here to visit Figure 19 – Ring Shadows disabled =click here to visit 
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Stars Displays a sky full of stars.  Obviously a key part of the Celestia experience.  Normally 
selected (no keyboard shortcut).  Highly Recommended.   

 
 
 
Stars/As Discs or Points [Ctrl + S]  Celestia can display stars either as points, scaled discs or fuzzy points.  

Which looks better is a matter of personal taste and the resolution of your monitor.  In 
general, a scaled disc forms a prominent circular disc that varies in both diameter and 
brightness based upon the actual size, magnitude and distance of the star from you.  
For example, a bright Red Giant star nearer Earth will be a larger reddish disc in the 
sky with this option enabled, while a smaller main sequence yellow star will appear 
smaller and dimmer in size.  Scaled discs are not designed to mimic the true visual 
appearance of the sky.  Instead, they enable you to locate stars by type and magnitude.  
Fuzzy points take a similar approach but draw a smaller, more realistic “point” that 
varies in size and brightness.  When your monitor screen resolution is above 800x600 
or higher, fuzzy points make a clearer distinction between brightnesses of a star and 
can produce a realistic sky view.  The 3rd option, stars displayed as Points, tend to be 
of similar brightness but look better at 800 x 600 and lower resolutions.  Selecting 
Points may also make Celestia run faster 

 
 You can cycle between the three star styles with [Ctrl+S] or you can set the style by 

using the Star Style sub-menu on the Render Menu.   
 
           Figure 20  - click here to visit          Figure 21    Figure 22 
 
 
 
 
 

 
 
 
 Cassini  against stars 800x600 

resolution – Scaled Discs enabled 
Same scene with Fuzzy Points 
enabled 

Same scene with Points enabled

 
 
 
Markers [ Ctrl + K ] and  [ Ctrl + P ]  - When enabled by pressing the [Ctrl+K] keys, Celestia will draw a 

small square box around/in any object you select and mark.  To mark an object, simply select it with a 
single or double click of the left mouse 
button so that its name appears in the 
upper left corner.  Then, right-click on it 
and choose “Mark”.  You can also press 
[ Ctrl + P ] from the keyboard to mark an 
object.  You can mark as many objects as 
you like.  Objects not currently selected 
will have a green mark.  Current objects 
will have a red mark.  To unmark an 
object, right-click on it and choose 
“Unmark”, or press [ Ctrl+ P ] again.  
To turn off all Marks, press [ Ctrl + K ] 
again.  Marks are very useful for tracking 
an object in space that you’ve lost sight 

Figure 23 - Voyager 2 marked 
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of, or for highlighting objects so that you can find them easily again.  For example, you can mark the 
Voyager 2 spacecraft as it speeds alone out of the Solar system.  No matter where you travel in space, 
you can always see it by scrolling across the sky to locate its mark.   

 
 Note:  All Marks are erased and reset to zero when the program closes. 
 
 
Orbits/ Labels   New: -  The central region in the View Options menu provides you the ability to turn on or off 

various labels for planets, major stars, moons, etc., and to select which orbit paths you want 
Celestia  to draw.  Turn them on or off as you desire by checking the boxes.  They do not use 
much computer power.   

 
Labels keyboard shortcuts are:  
=    Toggle constellation labels 
B    Toggle prominent star labels 
E    Toggle galaxy/nebula labels 
M   Toggle moon labels 
W   Toggle asteroid labels 
Shift + W Toggle comet labels 
n    Toggle spacecraft labels 
p    Toggle planet labels 
Shift + &   Toggle location labels (see below) 

 
 
 
Information Text  This box allows you to choose how much data you want displayed when you select an 

object.  Pressing the [V] key also toggles the information display on or off through two 
levels of detail.  If you see no text at all on the screen, press [V] to turn it on. 

 
 
Filter Stars  This slider determines how many stars Celestia will draw at one time.  It regulates star 

number by how far away a star is from your viewpoint.  By default, it is set at 1,000,000 
light years.  Since the diameter of our galaxy (the Milky Way) is about 100,000 LY across, 
Celestia will draw all stars in its data base at this slider setting.  However, you can lower 
the slider and command Celestia to draw only closer stars.  For example, if you set the 
slider to 100, the program will only draw stars that are within 100 light years of Earth.  
Since this requires far less computing power than the highest slider value, this may be 
useful if the program is running slowly for you.  Lowering the slider will speed things up.  
Also, you may have a scientific need to only see the closest stars to your viewpoint.   

 
 
 
12) Locations [Shift + &] – under the Render menu  is a feature that directs the program to mark and label any 

city, mountain, sea, valley, crater, landing site or other feature you desire on a planet or moon, and display its 
name above its latitude and longitudinal position.  To enable this feature, press the [Shift + &] key.  Celestia 
comes with a default list of locations when it is installed onto your computer.  To toggle the list of features on 
or off, use the menu checkboxes in the Render sub-menu.  However, a many new locations files are being 
developed by Celestia users.  Some of them are available at 
http://www.shatters.net/~claurel/celestia/files/locations/  and at the Celestia add-on repository site at 
http://www.celestiamotherlode.net/index.html    The forum will also explain how to make your own list of 
locations.  To use a Locations list, locate and download a list file from the web and place it in your “Extras” 
folder in the main Celestia folder in/on your computer.  It will then display when the Locations option is 
enabled.  When observing a planet or moon from far away, only the largest or most important locations are 

http://www.shatters.net/~claurel/celestia/files/locations/
http://www.celestiamotherlode.net/index.html
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shown.  As you approach it, more labels will appear.  
To change the distance at which particular labels first 
appear, move the slider in the Minimum Labeled 
Feature Size panel in the Locations sub-menu.   

 
 Locations may be manually selected by entering their 

names (see :  Selecting Objects by Enter/Name/Enter 
Method section below).  Generally, you must enter the 
name of the planet or moon where the location is found, 
as well as the location itself.  For example, to locate and 
go to Cairo, press the [Enter] key and a sub-screen will 
appear in Celestia with a place to type an entry.  Type
'Earth/Cairo' (or 'Sol/Earth/Cairo' if you are outsid
the Solar System.), then press [Enter] again and the [
key to go there.  You will be taken by the program to a
position located directly above Cairo.  Note that if th
location is on the opposite side of a planet from where you are, Celestia will take a shortcut 

 
e 

G] 
 

e 
through the plan

and stop above the location you select, but facing into space.  You will have to rotate your view to see the 
location (see later sections for how to rotate your view).   

Figure 24 – Locations features enabled

et 

 
 
 
13) Stars Visible – { [ } or { ] }  - On the Render menu, select “More or Fewer stars visible”, or toggle with 

the keyboard shortcuts.  This tells Celestia how many stars to draw in the sky at one time.  It controls star 
numbers by Apparent Magnitude (visible brightness).  You can choose to display only bright stars.  On the 
surface of Earth, our view generally includes stars of an apparent magnitude of +6.5 or less (the lower the 
number, the brighter the star).  Setting this option to Magnitude 6.5 – 7.5 results is a realistic sky as seen from 
the surface of Earth on a clear night, with only about 3,000 stars visible.  However, if you were living on a 
space station far above earth’s atmosphere, you might see stars up to a magnitude of 9.0 or 10.0 with the 
naked eye.  Because there are more stars in the sky, many Celestia users prefer higher star settings of 8.0 to 
10.0.  The keyboard shortcuts are very useful here.  Experiment by using the keyboard key “[“   to decrease 
limiting magnitude (fewer stars visible), and “]” to increase limiting magnitude (more stars visible).  Note that 
by turning stars on or off, you are changing the amount of data Celestia must process each second.  If you are 
experiencing slow performance, try reducing the star count. 

  Figure 25           Figure 26  
 
 
 
 
 
 
 

 
 
    Stars at Magnitude setting of 7.5             Same scene at Magnitude setting of 15.0.     
 
 
 
14) AutoMag - [Ctrl + Y] - The default download of Celestia actually contains about 100,000 stars up to 

magnitude 15.0 visible from the vicinity of Earth.  A setting of 11.0 or more simulates the view you would 
see through a telescope.  However, millions of stars have been cataloged by Astronomers and if you wish, you 
can download a star database from the Celestia website that contains over 2,100,000 stars.  You can find it 
here.  If this file is loaded, and you select the maximum magnitude limit of 15.0, the sky will be ablaze with 

http://perso.wanadoo.fr/celestia.stars/
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stars.  Note that this level of star display will dramatically slow down even fast computers.  The choice is 
yours.  Fortunately, Celestia helps you to set realistic star magnitudes with a feature known as AutoMag.  To 
enable AutoMag, press the [ Ctrl+Y ] keys.  To disable it, press them again.  When Automag is enabled, 
Celestia will turn on or turn off stars to maintain a reasonable visual range whenever you change your field of 
view (FOV).  It will also restrict the view to a range of 6.0 – 12.0.  A screen display will advise you of your 
changes.  

  
 
15) Star Style  – Toggles between scaled disc, fuzzy points and points, as discussed earlier. 
 
 
16) Ambient Light -  [ Shift + {  ] or [ Shift +  } ]  - On the “Render” menu, select “Ambient Light”.  Since 

space is a near vacuum, there is very little light scattered and shadows are completely black.  You can set the 
ambient light level to “none” to simulate this and get the most realistic views of space.  However, there are 
times when a bit of extra light is useful or aesthetically pleasing.  For example, go to the dark side of any 
planet and adjust ambient light from None to Low, then to Medium.  You’ll discover that portions of a 
planet’s dark side become visible with some light scattering.  Having a bit of extra light is also good for 
seeing spacecraft.  When they’re on a planet’s dark side, they almost disappear in the shadows.  Low or 
medium light allows you to track them better.  Use [ Shift + { ] to decrease ambient light and [Shift + } ]  to 
increase it through several step levels.    Remember that no light scattering (None) is the accurate view when 
in space. 

 
 Figure 27 – click here to visit    Figure 28 
 
 
 
 
 
 
 
 
 
 
 
 
 Pluto and its moon Charon with Ambient Light set to None             Same scene with Ambient Light set to Low.     

  

 

17) Antialiasing -  [ Ctrl + X ] -  On the Render menu, select “Antialiasing”.  These are instructions to Celestia 
to use certain graphical processing and smoothing techniques when it draws lines on the viewscreen.  In 
general, Antialiasing evens out the lines used to draw sharp edges of spacecraft, orbit paths and constellation 
figures.  Highly Recommended - but does require computer resources.  Try turning off if Celestia is running 
too slowly.  Note that anti-aliasing may not be available if you do not have a higher quality graphics video 
card on your computer. 

 
 
 
18) Vertex Shading -  [ Ctrl + V ]  Not in the Render menu but controlled via keyboard, Vertex Shading is a 

computer graphics drawing technique that draws (renders) graphical shades (haze, shadows, specular 
reflections off of water or ice, etc.) on Celestia objects.  To see such shading, your must have a graphics 
accelerator card that renders shading via a process known as Open GL.  However, as mentioned earlier, not all 
graphics cards can handle vertex shading properly.  Celestia now handles Vertex Shading automatically.  
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With higher end cards, Celestia gives you five choices for Vertex Shading.  They are:  Basic, Multitexture, 
Nvidia Combiners, Open GL and Open GL/Nvidia Combiners.  The number of these available render 
paths you can cycle through with [ Ctrl+V ] depends on the graphics card and driver version you have.  By 
default, Celestia detects the type of graphics card you have and starts up your program with the highest 
quality rendering possible.  If you have an Nvidia Open GL Graphics card, all five choices will be offered.  
Using the [ Ctrl+V ] keyboard shortcut, select the last choice (Open GL/Nvidia Combiners); observe Earth 
and then cycle through the other choices.  You will see surface shadows and a haze appear or disappear on 
Earth.  If you have another brand of graphic accelerator card, cycle through whatever choices Celestia 
presents to you.  If you have no graphics card at all (i.e. – your computer has a minimal built-in graphics 
processor), the Basic or Multitexture settings are your only choices.   

 
 Figure 29 – click here to visit     Figure 30 
 
 
 
 
 
 
 
 
 
 
 Open GL/Nvidia Combiners render path selected  Same scene with Basic render path only 

     

Note:  Keyboard shortcuts for turning on and off (toggling) the options and features described above, along with 
other keyboard shortcuts, are listed in printable format at the end of this document." 
 
 
 

Alternate Textures and Surfaces      
 

19) Celestia comes with a moderate collection of textures (graphical files) that the program uses to draw the 
surfaces of planets, moons, asteroids, spacecraft, etc.  Celestia takes great care to try to include textures that 
are true and complete or partial photographs of the planet or moon.  In that way, the program’s images are 
impressively accurate.  However, add-ons developed by forum members and others are available for 
download from various websites in the Celestia community that define Alternate Surface maps for some 
space objects.  For example, you can command 
Celestia to load an image of the Earth as it may 
have looked 4 billion years ago, soon after it 
formed.  Its surface will be covered with craters 
and lava flows.  Another Alternate Surface 
available for Earth is this latitude and longitude 
grid (figure 31), that overlays a map of the 
equator, prime meridian, Tropics of Cancer and 
Capricorn, etc. onto a modern image of the 
planet.  A third popular Alternate texture is of 
Earth at the time of the Ice Ages.  See the planet 
covered in ice, and the extent of the ice sheet 
boundaries.  Alternate surfaces are also often 
used for global maps of temperature, elevation or 
other data.   

Figure 31 – Alternate “Grid” texture 
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20) Only one Alternate surface is displayed at a time.  To choose an Alternate Surface, right-click on the object.  
If an Alternate Surface is available (has been installed in your program files) it will appear in the menu that is 
displayed.  Simply click on its name and Celestia will load and draw the Alternative texture.  To return to the 
original “normal” texture, right-click on the object again, choose “Alternate Surfaces” and select the 
“Normal” texture. 

 
There are times when you might wish to have two alternate textures displayed at the same time, representing 
different bodies.  For example, you might have an image of the Primitive Earth and the Primitive Moon in 
your texture files and want Celestia to draw both of them together.  To do this, you must locate those files in 
your Celestia texture folder and name both of those files with the same name.  For example, if you name the 
Primitive Earth texture “Primitive”, and the primitive Moon texture “Primitive” and place them in two 
different folders, both will be drawn.  The step by step procedure for doing this is a bit too complex to cover 
here in depth.  A posting on the Celestia forum will help you accomplish this, if you so desire. 
   

21) Limit of Knowledge Textures [ Shift and + ] key - The surfaces of some of the bodies in our Solar System 
have only been mapped or photographed incompletely.  By default, Celestia uses surface maps that have the 
unknown regions filled in with plausible surface features, typically cloned from some part of the body that has 
been imaged.  But Celestia also includes a set of maps called 'limit of knowledge textures' (LOK) that 
depict the unknown areas as blank, clearly showing where our spacecraft have and have not aimed their 
cameras.  The [ + ] key toggles between the default 'interpretive' maps and the limit of knowledge textures.  
You can also load them with a right-click and selection of “Limit of Knowledge” from the context menu. 

 
 
 

Movement 
 

22) General movement in Celestia is one of the highlights of this amazing program.  It is easy and versatile.  
Movement keys are very important for enjoying the Celestia universe.  For example, if you wish to go into an 
orbit hovering above a planet, drop down to its surface or fly in your spaceship to the edge of the Milky Way, 
you will need to change direction, orientation and distance in space frequently.  There are 16 keyboard or 
mouse general movement commands.  Let’s return to our opening scene of the Earth (to do so, click here) 

 
a) [Right-click] on the scene in front of you and while holding down the right mouse button, move your 

mouse (Right-click-drag).  Earth will rotate left, right, up or down.  You can view it from any 
perspective you wish.  

b) [Left-click] your mouse and while holding the button down, drag the mouse.  The whole scene will shift 
as a whole (Left-click-drag). 

c) Tap the [down ↓ arrow] on the keypad or [# 2] on numeric keypad.  Your view of Earth will pitch 
upward.  Before you use the numeric keypad, make sure you press the key labeled “Num Lock” at the top 
of the numeric keypad.  If so, there should be a little light lit up above the numbers on your keyboard.  

d) Tap the [up ↑ arrow] on the keypad or [# 8] on numeric keypad.  Your view will pitch downward. 

e) Tap the [left ← arrow] on the keypad or [# 7] on numeric keypad.  Your view will rotate (roll) 
clockwise. 

f) Tap the [right → arrow] on the keypad or [# 9] on numeric keypad.  Your view will roll counter-
clockwise. 

g) Tap the [# 4] key on the numeric keypad of the keyboard.  The view will swing (yaw) to the left    

h) Tap the [# 6] key on the numeric keypad.  The view will swing (yaw) to the right as a whole. 

i) Tap the [# 5] key on the numeric keypad to stop all pitch, roll and yaw movement. 
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j) Hold down the [Shift] key and press one of the [Arrow] keys (e.g.  [ Shift+→ ] .  You will “orbit” 
around the object in view, either left/right, or up/down.  This is convenient to see all of an object quickly. 

 

Note.  The speed with which the view turns when you press the above keys is initially set at a particular value 
(120) in one of the files that Celestia uses to operate.  That file is called celestia.cfg, and can be found in the main 
(root) directory of the Celestia folder.  If you find that your view is turning too fast or too slowly for your taste 
when you press a movement key, that document can be opened by you and the Rotate Acceleration (turning 
speed) of the above keys can be lowered or increased.  To do so, double-click on the file.  If a menu comes up 
asking you which program you wish to use to open the document, choose “WordPad” (for Windows systems) or 
the proper plain text editor for MAC and Linux systems.  When open, locate the line “RotateAcceleration 120” 
and change the number either higher (to turn even faster) or lower (to turn more slowly).  For example, 
RotateAcceleration 35 will result in your view turning more slowly when you hit a movement key.  Some users 
prefer the increased control it gives them, particularly if they use the Celestia spaceship.   

NEW - You will also find that a variety of other commands in the celestia.cfg file can be changed by you to alter 
the way Celestia does things.  Read the document’s text directions and make any changes you wish.  After 
changing, save the change by clicking the File and SAVE menu choices, and close the document, then relaunch 
Celestia.   

 

k) [Right-Click + Left-Click + Drag] – (press all together) - your position will advance toward or recede 
away from the object. 

l) [Ctrl + left Drag] – same as (k) above.  

m) [Roll Center Mouse Wheel] (if you have one) forward or backward – same as (k) above.   

n) Press the [End] key on the keyboard.  This is the same as (k) but using the keyboard only.  Your position 
above any object will rapidly recede away.  Hold down the key and you can move light years away. 

o) Press the [Home] key on the keyboard.  Your selected object will rapidly advance toward you.  

The above five keys resemble a “zoom” ability.  However, they don’t magnify an image; they just 
reposition you toward or away from it.  Because this feature operates exponentially, you can move 
smoothly and rapidly from a distance of one meter to one million light years away from a Celestia object 
without sacrificing precision at small distances, or experiencing long time delays traveling long distances. 

 

p) Press the [ Shift + * ] on the keyboard.  This is a Lookback command.  It will reverse your view so that 
instead of looking forward, you will look behind you (a rearview window).  It is very stimulating when 
flying from one planet to another or traveling in your spaceship.  You can see forward and then examine 
your journey from the rear view, watching the planet or moon you just left recede from you. 

 
 
 

 Joystick Control   [F8] 
23) You can also control your movement via a joystick (Windows only).  The commands for joystick control of 

Celestia are listed in the back of this document, in the Keyboard and Mouse Command Summary.  Press 
the [ F8 ] key to turn Joystick control on or off. 
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 Selecting Objects 
 

24) In Celestia, you will usually have some object selected.  If so, the program will list its name in the upper left 
corner.  It can be a star, planet, moon, asteroid, comet, spacecraft, galaxy/nebula or location.  The simplest 
way to select most objects is to point at it with your mouse and [left-click] on it (note - point/click does not 
work with Locations).  Return to Celestia and try clicking once on a star to select it.  The information display 
changes to details about the star.  Note that you have not actually gone there or changed anything yet.  You’ve 
simply told Celestia that you have selected a new object (if you see no text on the screen, type the [V] key on 
the keyboard.)    

 
25) To go to the star you just selected, you have four main ways to make the journey (practice doing all four):   
 

A)  If you right-click on the selected star, and select “Goto”, Celestia will take you at hyper-light speed 
directly to that star and position you in space at a convenient distance.   

B)  Alternately, you can press the letter [ G ] on the keyboard.  That is the shortcut command for “Goto”.    

C)  You can select the star and fly to it in your spaceship.  It takes longer but sometimes the journey is half 
the fun of getting there.  How to operate your spaceship is explained later below. 

D)  You can also select an object using keyboard commands, then use the advance [Home] key, or recede 
[End] key to get there.  To do so, simply point at a star or planet, left-click on it with the mouse so that it 
is selected and tap both the [ C ] and the [ F ] keys on the keyboard.  The [C] key tells Celestia to center 
a selected object in the middle of your viewscreen.  [Double-clicking] quickly on an object will also 
center it.  The [ F ] key tells Celestia to follow the selected object, keeping it the same distance from you 
even though it is moving through space.  Let’s try it!.  Point at a star, left-click on it to select it, and tap 
the [ C ] key.  It will swing and become centered.  Then press the [ F ] key.  The words “Follow 
___(star’s name)____ ” will appear in the lower right of the screen.  Now that you are following that 
object, go to it by holding down the advance [Home] key.  When you get there, back away from the 
object using the recede [End] key.   

26) Go to Surface [ Ctrl + G ] –  If you are following an object, pressing this key combination will take you 
directly to the surface, looking at the horizon.  Although it will work for all space objects, it’s designed for 
planetary bodies, moons, etc. 

 
27) GO HOME  [ H ]  - To return to our Solar System from anywhere in the universe (a very useful thing), press 

the [ H ] key on the keyboard.  That will select “Sol” (the Sun).  Tap the [ G ] key and you will be whisked 
back to our Sun.  Note: You will use these two keystrokes constantly as you explore the Celestia universe and 
wish to return home.   

     
28) To cancel a current selection, hit the [Backspace] key once on the keyboard.  To cancel a navigation 

command such as Follow or Track or Center, press the [Esc] key in the upper left of your keyboard.  You 
will now be adrift in space.  Objects will still be selected and you can return to going to them, following them 
or tracking them, etc. by simply hitting the [G], [F] or [T] keys again.     

 
29) [Right-Click]:  There is another way to select objects and is one you will use often.  To demonstrate it, click 

here.  You will be taken to a position above the planet, Jupiter.  [Right-click] on Jupiter to bring up a menu of 
options.  One of them is “Satellites”.  Choose it and a list of Jupiter’s moons will appear.  Left-click on any 
one of them and press the [ G ] key to travel to it.  You can use the right-click feature when the object you 
visit orbits the Sun or planet directly.  If there is no “Satellites” option in the menu that appears with a right-
click, that means the planet or moon has nothing else orbiting it. 

 
All of these keyboard key shortcuts are again summarized in a later section. 
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Navigation Menu 
 

30) Celestia has a complete menu dedicated to space navigation that you can use often.  Some of the choices are 
single commands (e.g. – Select Sol).  Others open dialog boxes that give you some choices to make, or ask for 
some input.  Specifically: 

   
Select Sol   [ H ] 

31) The Navigation Select Sol menu item directs Celestia to “select” our Sun (called by its Latin name, Sol).  
You can select and locate it in space from anywhere, even from far outside of our solar system.  It is very 
useful to do when you are far from home and simply want to return to our solar system.  The keyboard 
shortcut for selecting Sol is [ H  ].  Please note that all you have done at this point is select the Sun.  You have 
not gone there or even centered it in your viewscreen.  To do that, you must enter a 2nd command, as 
described later below. 

 
Tour Guide  

32) The tour guide opens a pulldown list of a few of the more interesting objects you can visit in Celestia.  Select 
the “Tour guide” option in the Navigation menu to bring up the guide window, choose a destination by 
clicking on the pulldown arrow and selecting from the list, click the “Go To” button, and click OK to close 
the window.  You're off.  We urge you to visit some of these stops on the tour.  NOTE:  As you become more 
experienced with Celestia, you can edit this file in your Directory and add your own tour stops. 

 

Select Object  

33) The Navigation Select Object option opens a dialog box that enables you to type the name of an object you 
wish to visit and then go there.  Select this option from the menu and in the space provided, type “Moon” and 
click OK.  Now, hit the [ G ] key and you will zoom to an orbit above our Moon.  Try another space object.  
Note that this option does not work for Locations.   

 
Goto Object  

34) Choosing this option from the Navigation menu opens the "Go to Object" dialog box.  There are two uses for 
this dialog box.  First, it can be used to find your exact position in relationship to objects you may already 
have selected.  For example, if an object (such as the planet Venus) is already selected when you choose this 
option, the information fields you see in the Dialog box will contain your current position in relationship to 
Venus.  This will include the object’s name, and your Latitude, Longitude and Distance above its surface.  
This is very useful when you are positioned above something and you want to know exactly where that spot 
is.  If no object is selected, the fields will be blank.   

 
35) You can instead, change the values and go somewhere else.  For example, type Mars, enter 30 for the 

latitude, 5 for the longitude and 5000 (km) for distance.  Click “GoTo”.  You will be taken to a position 5,000 
km above the surface of Mars, at 30° N latitude and 5° E Longitude.  You will automatically be placed in 
“Sync orbit” around the object, meaning that as it turns, you will turn with it so you are always above the spot 
you desire.  This is an excellent way to position yourself for eclipse events or above craters, etc.  Please note, 
however, that when you arrive, you may be on the dark side of a planet.  In that case, you may have to reset 
the clock to a time when daylight is shining on your position (see later discussion), or you can move your 
position to a different longitude. 

 
36) Note that Longitudes are + values for positions East of (0°E) and negative (-) for longitudes West of (0°E).  

For example, longitude -40 would be 40° W.  “Distance” is distance to the surface of the object. 
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Center Selection   [C] or   [Shift+C] 

37) This command will direct Celestia to reposition any object that you have previously selected in the center of 
your viewscreen.  It is used frequently in Celestia.  For example, if you select a star anywhere in the sky by 
left-clicking on it, you can center it by simply choosing this menu command in the Navigation menu, or 
pressing the [ C ] key on the keyboard.  Double-clicking on the object will also center it in your viewscreen.   

 
38) If you were orbiting a planet or star when you selected and chose to center a new object, you might or might 

not lose sight of your original object as the viewscreen moved to center the new object.  To compensate for 
that possibility, Celestia provides the [ Shift + C ] key combination.  Pressing both of them together causes 
the viewscreen to swing to center the new object you selected, without losing sight of the original.  To test 
this out, click here.  You will be taken to a position behind the Moon, with the Earth off to the right.  Earth 
has been pre-selected, but is not yet centered.  To do so, press the [ C ] key.  The view will swing to the right 
and the Moon will almost move off screen to the left.  Return to your starting view by clicking the above link 
again, but this time, press the [Shift+C] keys together.  Earth will again center, but the Moon will still be fully 
visible.  Your view will take up position at a new position behind the Moon.  This feature is obviously useful 
if you do not want to lose sight of the original object as you sight and center on a new one. 

 

Go To  Selection   [G] 

39) Previously mentioned, this command will direct Celestia to go directly to your selection, and position you a 
pre-calculated distance above it.  You can use it with any of the Selection options mentioned here or in the 
following paragraphs.  For example, if you select an object with a left mouse click, choosing this command 
from the Navigation menu, or pressing the [G] key as a shortcut, will send you directly to the object you 
selected at high speed.  If you choose it again or press the [G] key again, you will move closer to the object.  
[G] is used constantly in Celestia. 

 
 Follow Selection   [F] 

40) This menu and keyboard command will direct Celestia to lock onto the object selected and follow it.  As it 
moves through space on its orbit, you will move also.  The object can turn below you on its axis (if it is 
rotating) so the longitude will change constantly, but you will stay the same distance and latitude above it.  It 
is routinely used when you wish to take a position in space above a star, planet, moon, asteroid or a spacecraft 
and is highly recommended.  The keyboard shortcut for “Follow” is [ F ] and will be used very frequently. 

 
 
Sync Orbit Selection  [Y] 

41) This feature lets you hover directly over the same position/spot above an object that you have selected.  For 
example, if you are above Earth with Africa below you, selecting Sync Orbit will tell Celestia to keep you 
positioned above Africa all the time.  As the Earth turns below, so will you.  To see that effect, click here.  
Many of our satellites (navigation, weather, spy, GPS, TV and radio) are in synchronous orbit around Earth.  
You can use the command in fact, to hover above a particular satellite as it orbits its host planet or moon.  The 
keyboard shortcut for Sync Orbit is [ Y ].   

 
 
Track Selection  [T] 

42) This command tells Celestia to track a selected object, keeping it centered in view.  The keyboard shortcut for 
Track Selection is [ T ].  To be useful, the selected object should first be released from other effects, then 
reacquired and tracked.  For example, if you are currently following and/or are centered on Earth, first release 
your hold on it with the [Esc] key.  Earth will begin to move away from you at the speed it actually travels in 
space (about 47,100 mph, or 78,500 km/hr). If you watch long enough, it would drift off the screen.  
However, if you [left-click] on it to re-select it and choose the Track Selection command, Earth will still be 
drifting away but your view will swing to center and track it.  A particular excitement is to chase one of our 



Celestia User’s Guide              27 of 40 

interplanetary spacecraft or an asteroid using the Track Selection Command.  To see this in dramatic action, 
click here.  You will be taken to a position in space above the asteroid Gaspra.  You are tracking it and as 
you watch it coming at you, your view will swing as it flies by (just missing you) and you watch it recede.     

 
 
Chase Selection  [“] 

43) Although not in the Navigation Menu, this command is available by pressing the quotation [ “ ] key on the 
keyboard  [ shift + “ ].  It instructs Celestia to chase a selected object in space.  It is similar to the “Follow” 
command but locks you above the object at the same position while the object is moving.  Try comparing the 
two commands. 

 
 
Lock Selection  [:] 

44) Not available in the Navigation menu but available through a keystroke [ Shift + : ], the Lock command is 
used in conjunction with other commands to bind two separate celestial objects together in space.  For 
example, click here to select Jupiter and follow it.  You will be positioned above Jupiter with its moon Io 
prominently in front of you.  Notice that Io is slowly moving in its orbit around Jupiter.  Now, left-click once 
on Io to select it, and press the [Shift + : ] keys.  The display in the lower right corner will now say, “Lock 
Jupiter – Io”.  The command will place you in a position that remains stationary above both objects, even as 
they move in space.  To see that effect, click here.  You will be taken to the same spot with time speeded up 
and the two objects locked to each other.  The sky behind them will be moving, but your viewpoint will be 
“locked”.  This command is also particularly useful for watching spacecraft orbiting around planets.  Go to 
and “follow” the spacecraft of your choice, then [left-click] on the planet below, press the [Shift + :] 
keystrokes and the spacecraft will be locked around the planet.  As it orbits, you will have sight of both of 
them.  To see what we mean, click here.  You will be locked above Earth with the Hubble Space telescope 
orbiting below you.   

 

45) Note:  When interacting with an object, you can choose the Follow, Center, SyncOrbit, Track, Chase and 
Lock commands at any time.  Center and Track can be used alone or in combination with the other 
commands.  The others will execute only the last command given.  For example, if you are “Following” an 
object and press the Chase or Sync Orbit command, it will replace the Follow command.  If you press the [T] 
“Track” key, however, you will both be following and tracking your target object (both work together).  If 
you type the [Esc] key, the current object will be released from all commands.  To “unlock” two objects, 
replace the lock command with another one such as the [F] command, or press the [Esc] key.   

 
 
Solar System Browser: 

46) At the top of the screen, select the Navigation menu and choose Solar System Browser.  A complete list of 
all objects being tracked in our Solar System by Celestia will appear.  Next to planets or moons may be a + 
sign, which indicates that around them are more objects to choose from.  Select any one of them and choose 
either to “Center” it, or “Go To” it.  Centering is useful when you want to see where an object is in space 
without going to it, or when you want to use your spaceship to journey to that planet, and you want to locate 
and center it first.  Go To is used when you just want to get there fast.  You should use this navigation menu 
frequently, since it is the complete list of all objects in the solar system, including all moons and spacecraft.  
Try it.  Go to Neptune, Saturn, or one of their moons.  Please note that if you are in another star’s 
environment or solar system, its list of planets, moons and space objects will appear in the Browser instead.  
Also please note that the default download of Celestia comes with only a few spacecraft.  However, over 40 
other spacecraft are available as add-ons from the Celestia add-on repository and other sites, and will all 
appear here in the Solar System Browser list if you install them all in your files.  To get add-ons, see our 
prior discussion. 
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Star Browser: 

47) Select the Navigation menu and choose “Star Browser”.  A list of some of the stars being tracked by 
Celestia will appear.  Clicking on the column headers at the top of the menu will sort the stars different ways. 
For example, if you click on the word, “Distance”, Celestia will sort the list of stars by distance from our 
Sun.  If instead you click on the column header titled “Type”, Celestia will sort the list according to the star’s 
stellar classification (O,B,A,F,G,K,M, W).   

 
48) The slider at the bottom of the list determines how many stars will appear in the list, from just 10 stars, to as 

many as 500.  You have your choice of “nearest”, “brightest” or stars “with planets”.  For example, if you 
choose 500 stars with the slider and click the “brightest” dot, Celestia will list the 500 brightest stars in the 
sky as seen from your current position.  If you are in orbit around Pluto, it will list the 500 brightest stars as 
seen from Pluto.   
 

49) Although extrasolar planets have not yet been seen directly or photographed, gravitational and other evidence 
strongly points to their existence.  To give you an “up-to-date” astronomy experience, Celestia includes some 
hypothetical planets that have been placed around candidate stars.  In addition, Celestia’s many users have 
designed fictional solar systems that they have placed around some of the stars in our sky.  When 
downloaded, their solar systems will appear here in the star browser list also.  Selecting the “With planets” 
option will enable you to locate the stars that have planets, including fictional ones.  Remember though that 
the star has to be reasonably close to Earth.  This menu will only display the first 500 stars that have planets.  
If a solar system is far out in space, it may not be visible in the list.  To practice such a journey, locate the star 
51 Peg in the star browser list (make sure you choose the “with planets” option), and select “Go To”.  You 
will fly at great speed to a bright yellow star much like our Sun.  A planet will be seen near it.  Either point to 
it and left-click to select it, or right-click on the star 51 Peg when you get there and select the planet (named 
“b”).  Press the [G] key on the keyboard and you will be taken to the planet, which will appear as a big 
blue/green gas world similar to Uranus.  Using your movement keys as described earlier in paragraph 22), 
you can move around this tiny solar system.  Notice that the Solar System Browser in the Navigation Menu is 
no longer listing our solar system.  It now lists the one planet system of 51 Peg.  To return to Earth, press [H] 
to select the Sun, then [G] to go to it. 

 

Eclipse Finder 

50) The last menu item in the Navigation menu is Eclipse Finder.  When selected, Celestia will calculate and 
provide you dates of all partial and total solar or lunar eclipses for all planets and moons in its database, and 
offer you the option to go there to witness the eclipse.  Simply select the type of eclipse (solar or lunar), the 
planet and the date range you desire, and click “Compute”.  When a list comes up, pick one, click the “set 
date and GoTo the planet” button, close the dialog box by clicking the “Close” tab and enjoy the show.  As 
an example, here is a very exciting double eclipse of Jupiter by two of its moons (Io and Europa) that took 
place in January, 2003.  The shadows of both moons can be seen on Jupiter’s clouds.  Once the eclipse is 
finished, Europa (the moon closest to you), then eclipses Io (the more distant moon).  To see it, click here, 
and watch it unfold by examining both Jupiter and Io.  All eclipse shadows in space are actually composed of 
an inner shadow (the Umbra) and outer shadow (the Penumbra).  Celestia draws both.  See figure 12 for an 
example of a total solar eclipse on Earth.  The Umbra is the darker inner shadow.   

 
Important Notes:  To see eclipses, you must have “Eclipse Shadows” selected in the Render Options menu.  
Also note that once you examine an eclipse, you will be in a new date in Celestia.  To return to your current date 
and time, press the [ Shift + ! ] key.  
  
There is a limit to what Celestia can display between dates that are far apart.  For example, Jupiter has 63 moons.  
They all have the capability to pass between Jupiter and the Sun very frequently.  If you ask Celestia to compute a 
list of solar eclipses between say 1920 and 1990, the list will become so long that it will lock up the program.  
Therefore, when dealing with the four outer gas giant planets of Jupiter, Saturn, Uranus and Neptune, (they all 
have lots of moons), please keep your request dates between a narrow range of a year or so.   
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a. Although Celestia will try to position you exactly above the eclipse event, it doesn’t always get it right.  
You may find yourself above an eclipse but not see anything.   

b. Once you have activated the Eclipse Finder and gone to view an eclipse, the program will attempt to 
“Lock” you to the next object you select, even if you don’t want to be locked.  For example, if you click 
on a star to select it after viewing an eclipse through the finder, Celestia will lock the planet you were 
watching with the star.  If you then try to go there or anywhere else, the program may stop working.  If 
this happens, try pressing the [Esc] key.  Then try selecting and going to another object.  We will have a 
fix soon for these bugs.  Please be patient.   

 

 

Select Objects by Keystroke 
 

51) There is another way to select planets.  The nine (9) planets in our Solar System have been given numbers 
from 1 for Mercury to 9 for Pluto.  The Sun is number 0.  To go to one of them, you can simply press the 
number at the top of the keyboard (not on the numeric keypad to the right) and hit the [G] key.  For example, 
pressing [3] and [G] will take you to the 3rd planet, Earth.  If you are in another (fictional) solar system, 
number keys will also work, but it will be that solar system’s objects that will be selected.  If you press the 
[H] key, then [G], you will always be taken back to our Sun “Sol”, no matter where you are in the universe.  

 
 
 

  Selecting Objects by Enter/Name/Enter Method 
 

52) You can also select an object or a Location via a convenient keyboard command.  Hit the [Enter] key and the 
“Target Name” window will appear at the bottom of the screen.  Type the name of some object you wish to 
visit, such as a planet or moon or star or spacecraft, or location.  As you begin to type, Celestia will present 
you with a list of objects that begin with the letters you are typing.  For example, if you type the letter [M], 
Celestia will display a list of up to 12 objects in its data base that begin with an “M”, such as Mars, the Moon, 
Mir, Mercury, etc.  Note that the program has room to display only 12 objects.  Celestia, therefore, starts with 
all objects closest to you and displays the first 12 it finds in its database.  As you type the 2nd letter in your 
object’s name, the list will now display only those objects that contain both letters.  For example, typing 
“Ma” will reduce the list to only Mars, and perhaps another object you may have as an add-on (e.g. the 
“Magellan” spacecraft).  You can complete typing the name, or you can simply press the [Tab] key to cycle 
the cursor from word to word in the list.  When you reach the word you desire, just press the [Enter] key 
again and Celestia will complete the spelling for you (auto-complete) and select the object.  Now to go there, 
all you have to do is press the [G] key or use the [Home] key.  Try it.  Press the [Enter] key and type a single 
letter.  A list of objects will appear.  Type a 2nd letter.  The list will shorten.  Use the tab key, cycle through 
the remaining objects to any one you wish and press [Enter] again.  You will have selected that object.  Once 
selected, you can use all the object commands such as Center, Follow, Lock, Track, Goto, etc. 

53) If you are seeking a named Location on a planet or moon, you must enter the name of the planet or moon 
where the location is found, as well as the location itself.  For example, instead of typing simply 'Cairo', you 
must enter 'Earth/Cairo' (or 'Sol/Earth/Cairo' if you're outside the Solar System.)  The slash mark / is 
needed.   

 
54) One problem that you may encounter is what to call an object.  You can use common names or Bayer and 

Flamsteed designations and HD or HIP catalog numbers when entering stars and space objects in all of the 
Navigation and Enter menus.  Celestia stores star data taken from the HD catalog but if a star isn't in the HD 
catalog, the HIPPARCOS data set number is used (the prefix is "HIP").  Both the 1st name or number and 2nd 
name of the object/star can be spelled out or abbreviated (3 letters), with a space between them.  Examples: 



Celestia User’s Guide              30 of 40 

Upsilon And 
Ups Andromedae 
Ups And 
51 Peg   Note:  This is 51_Peg, not 51Peg 
51 Pegasi 
HD 173739 
HIP 5643 
 

Planets, moons, asteroids and artificial satellites may be named by their common name (e.g. Mir or Jupiter or 
Io), or they can also be specified using Celestia’s “path” syntax.  Type the name of the star, followed by a 
forward slash, then the planet name/, then the moon or satellite name, etc.  For example: 

51 Peg/b 
Sol/Earth 
Sol/Earth/Moon/Apollo11 
Sol/Earth/ISS 
Sol/Jupiter/Europa 
 
 

Flying your Spaceship 
 

55) What good is a space simulation program if you cannot fly around in it?  The designers of Celestia have 
created a seamless and beautiful way to fly through the Celestia universe.  You are in command of your own 
hyperdrive spaceship.  The video screen in front of you is its window.  You can use this ship to fly through 
the Solar System, chase planets, drift above moons, try your hand at rendezvousing with spacecraft or visit 
another star.  Start some beautiful music playing and your journey can become more stirring.  Right now, 
your ship is stopped.  Let’s get it moving.  Click here, and you will be positioned about 6,400 km above India.   

 
56) Now, press and hold down the letter [ A ] on the keyboard for a second or two.  This is the throttle for your 

spaceship.  You will begin moving forward.  Your speed is shown in the lower left of the screen.  You will 
start slowly (in meters/sec).  As you hold down the [ A ] key, Celestia increases your speed exponentially.  
Accelerate to between 18 and “20 km/s” (20 kilometers/sec or 43,000 mph), which is a bit faster than our 
fastest spacecraft (the Voyagers) have ever flown.  Don’t worry about exact speeds, just get close.  Earth will 
begin getting bigger as you fly toward it on a collision course.  To change course, simply tap the arrow or 
other movement keys described in step 22), and your view (and forward direction) will change to a new 
orientation.  You will miss and fly by Earth. 

57) To slow down, press or hold down the [ Z ] key.  Your speed will drop (the Brake). 

58) To reverse course instantly, simply press the [ Q ] key.  Now, you will begin flying away from Earth at the 
speed you selected.  Press [Q] again and you move forward again.  This command is useful if you overshoot a 
target.  Just reverse course and the target will again come into view in front of you. 

59) To emergency stop, press the [ S ] key. 

60) Celestia gives you the opportunity to accelerate to a “hyperspeed” billions of times faster than light (c).  Just 
keep holding down the [A] key to speed up.  The [A] and [Z] keys are exponential speed controls.  As you 
gain speed, the stars will wiz by you like a scene from StarTrek.  You will quickly be taken out of the Milky 
Way entirely and into the blackness of the space between the galaxies.  You can journey to the very edges of 
Celestia’s universe.  There is not much to look at out there.  Swing the sky around and you may be able to 
notice some dim galaxies.  Generally, to see the Milky Way from outside of its confines, start your spaceship 
moving anywhere inside of our solar system, press the [Q] key to reverse course, accelerate to a warp speed 
of about 10 ly/s (light years/sec) and watch.  The stars and then the Milky Way itself will begin to recede 
from you.  Hit the [S] stop key and enjoy the view.  If you are following an object in our solar system, press 
[Ctrl+K ] to turn on Markers, then press [ Ctrl+P ] to mark your object.  A green box will appear in the disc 
of the Milky Way showing you where our solar system resides.  To return, press the [H] and [G]keys, or hit 
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the [Q] key to reverse course again, start your ship moving forward and you will fly back to your point of 
origin.  Please remember that Celestia only tracks a tiny few of the over 200 billion stars in the Milky Way.  
Galaxies contain FAR more stars than this program can track. 

 
Celestia  also provides shortcut keys for specific Spaceship speeds: 
F1 Stop 
F2 Set velocity to 1 km/s  
F3 Set velocity to 1,000 km/s 
F4 Set velocity to speed of light 
F5 Set velocity to 10x the speed of light. 
F6 Set velocity to 1 AU/s 
F7 Set velocity to 1 ly/s 
 

You can use these shortcuts to get moving at a particular speed, then use the [A] or [Z] keys to boost or lower your speed 
further. 
 
 

Telling Where You Are 
 

61) Celestia will provide you a general idea of where you are in space by simply looking at the information view 
display.  The top left corner identifies which object you’ve selected and how far away from it you are.  By 
changing objects, you can determine a rough estimate of where you are in space.  However, if you have taken 
up position above a star, planet, moon, etc., Celestia will tell you not only how far you are from it, but what 
latitude and longitude above it you are positioned.  To see that, pull down the Navigation menu and select 
“Goto Object”.  As long as you have an object selected, you will see your Distance, Latitude and Longitude 
from it.  If you are completely lost, simply go home by pressing the [H] and [G] keys. 

 
 

Adjusting Time (TIME MENU)  
[L], [K], [J], [Spacebar], [\], [!] 

 
62) Many events in space take place at certain times.  Planets experience seasons, spacecraft are launched and 

eventually fall back to Earth, moons eclipse the Sun on specific dates, comets pass by, space probes fly by 
target planets and take their measurements, etc.  Celestia gives you the opportunity to set a specific date and 
time, or to speed up or slow down the passage of time.  Your time will appear in the upper right corner of the 
screen.  For example, to see a planet turning under you, simply speed up the clock and it will rotate faster.  
Conversely, since objects in space move at thousands of km/sec, they will disappear from view if you release 
your hold on them.  To slow things down a bit and watch them move away, you can slow down time.   

 
63) You can use the Time menu at the top of the viewscreen to change the passage of time.  Simply pull down the 

menu with your mouse and choose an option.  However, most folks use the simple keyboard shortcuts.  They 
are: 

[Spacebar] stop or pause time 
[L]    Time becomes 10x faster (repeat for faster time) 
[K]    Time becomes 10x slower (repeat for slower time) 
[J]    Reverses time (it flows backward) 
 [\]  Returns to Real Time 
[Shift + !] Sets time to the current clock time 

 
64) For example, to see things move faster, position yourself hovering above Neptune and several of its moons by 

clicking here.  Notice that Neptune is not visibly turning (in real time, it takes 19 hours to turn once on its 
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axis).  Now, press the [L] key twice to speed up time to 100x faster.  Neptune will visibly turn below you and 
its moons will noticeably orbit the planet.  To see how slowing down time can be useful, let’s visit the Hubble 
Space Telescope again.  To do so, click here.  The HST is stationary because you are following it.  To see just 
how fast it is really traveling in space, release your hold on it by pressing the [Esc] key.  Hubble will recede 
from you at over 24,000 mph.  Now, press the [F] key to again follow Hubble and the [G] key to go to it.  
Slow down time with the [K] key to about -1000x slower, and release Hubble by pressing the [Esc] key.  It 
will now slowly drift away from you. 
 

65) To change a date in Celestia, pull down the Time menu and choose “Set Time”.  A dialog box will appear 
with pull down arrows, allowing you to reset the date and time.  The new time will be in Universal Time 
(UT).  To set the time to the current date and time, choose the “Set to Current time” button in the Set Time 
dialog box, or press the [!] key on the keyboard.  Note:  At present, you cannot manually reset a date in the 
future past the year 9999.  Resetting a date in the past can be done with this menu command backwards to the 
year 1800.  Dates beyond those boundaries can be reached by speeding up the clock and letting time run.   

 
66) Important Note:  Celestia has programmed some of its spacecraft to appear in space and then actually fall 

back to Earth (disappear) on the day that they really did so.  For example, the Russian space station Mir was 
launched on 02/20/1986 and fell back to earth on 03/21/2001.  To see Mir in orbit above the Earth, you will 
have to reset the date to some period between those two dates. 

 

 

Light Travel Delay 

67) Celestia has a feature called Light Travel Time Delay.  Light travels at a speed of 300,000 kilometers per 
second.  The sunlight we see on Earth actually left the Sun eight minutes before it reached your eyes.  
Pressing the [?] key [ Shift+? ] will display the one-way light travel time from the camera position to the 
currently selected object.  The minus [–] key controls light time delay adjustment; if it’s turned on, a message 
will appear and the displayed time of day in the upper right-hand corner of the screen will have the light time 
delay subtracted.  If you move your position, the time with move with you.  Most lists of solar system 
phenomena give times that include light time delay.  When observing these events with Celestia, automatic 
light time adjustment is extremely helpful.   

 
68) For example, if a transit of a moon of Saturn is set to occur at 14:00 hours and you are one light hour away 

from Saturn, pressing the [–] key will reset the time to 13:00 hours, so that you can witness the event in real 
time.  If you press [Home] and move closer to Saturn, the time will decrease as you approach the planet.  
Note:  Time delay does not function for stars, including our Sun. 

 

 
 NEW:  FILE Menu – Open Script 

 
69) Pull down the Celestia FILE menu and the first choice will be “Open Script”.  A script is a file with a .cel 

extension that commands Celestia to go certain places.  It can also have text.  The short Night Sky DEMO 
you may have taken at the beginning of this document is controlled by a script named “Demo.cel”.  If you 
have not taken it yet, click on the Help menu in Celestia and choose “Run Demo”.  Press the [Esc] key when 
done. 

 
70) Scripts are files written by Celestia developers and users to take you on a particularly interesting journey.  It 

controls the program and all you have to do is sit back and watch.  There are dozens of script files now 
available.  You can find many of them as add-ons in the Celestia Motherlode website.  Look for “script” in 
the add-on definitions.  If you do download a script, place the file into your Celestia main directory or into a 
folder dedicated to scripts.  Then, to launch/run the script, simply pull down the [Open Script] menu from the 
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Celestia FILE menu, navigate to (look in) the location of the script file, and open it.  For example, to open the 
Demo script, navigate to C:/Program Files/Celestia, and it will be listed as a file in that Directory. 

  
71) NOTE:  When a script is running, it not only controls where you go in Celestia, but it also changes some of 

the “Render” options that we discussed earlier.  For example, a script may turn off the clouds, or turn on 
Constellation labels in order to explain some particular point.  When the script is done, it may … or may not 
restore your Render options to the way you wanted them.  We recommend that after a script has run, you go 
back to the Render menu and make sure your preferred options are set just the way you like them. 

 
 

 FILE MENU - Saving Images, Movies and Locations 
 

72) Celestia gives you the opportunity to capture and save an image on your screen as an individual graphic file 
(such as the figures seen in this User’s Guide).  You can also save a series of images as a movie file and play 
it back later in your computer.  Thirdly, if you like a particular location and would like to return to that exact 
spot and time quickly, Celestia can save your location internally within the program as a “bookmark” or as an 
external “hyperlink” which can be pasted into another software program. 

 
Save Image  [F10] 

73) To save a graphic file (in .jpg or .png format), simply set up the screen exactly as you want it, pull down the 
“File” Menu and select “Capture Image” (or press the [F10] key).  A menu will appear.  Choose the folder 
you wish to put the file into, name the file, decide if it is to be saved as a jpg or png file and click “SAVE”.  
JPG files are common graphic files that have good quality and occupy less computer memory because they 
are first compressed by the program into a “smaller” size for storage.  Compression, however, always results 
in some small loss of image quality, in exchange for smaller file size.  Thus, jpg images can be convenient to 
use in e-mails, websites and documents where quality is not overly critical, and too large an image size might 
slow down the software or make it difficult to transfer over the internet.  Note, however, that before you can 
view a jpg file, your computer must first uncompress it, which takes a bit of time. PNG files are also 
somewhat compressed graphic files but they maintain a higher image quality due to the way they save data.  
As a result, they do require much more computer memory.  For example, an image save by Celestia would 
use about 60 KB of RAM memory in jpg format, and 360 KB of RAM if saved as a png file.  If you wish to 
use a Celestia image in a high quality presentation requiring the best image, save the file in png format.   

 
74) To view a jpg or png image, click on it and your default graphic image viewer or browser in your computer 

will open it.  You do not need Celestia running.  You can paste and view images anywhere you wish. 
 

Save Movie 

75) Celestia gives you the opportunity to create an animation/movie of anything you experience in the program’s 
universe.  For example, if you wish to position yourself beyond Jupiter and fly past it at high speed with the 
planet whizzing by, you can record that maneuver in a movie.  You can record a rare solar eclipse as it 
happens or demonstrate the occultation of a star by a planetary limb.  You can execute any command you 
wish while taping a movie.  For example, you can accelerate in your spaceship, move the screen with your 
mouse, zoom in or out, speed up time, etc.  In this manner, you can set up your own movie “demo” of 
celestial places or events for others to see.   

 
76) To save a movie file (in .avi format), set up the screen as you want it and set the time moving forward at the 

speed you desire.  We suggest you then temporarily pause time with the [Spacebar] key while you complete 
the movie preparations.  Pull down the “File” Menu and select “Capture MovieImage”.  Choose the folder 
you wish to put the movie into, and type a file name for the movie.  Then choose the size of the video.  
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Generally, “320x240” or “640x480” file are the preferred sizes.  320x240 creates a smaller sized image and 
requires less computer RAM to store.  640x480 and higher are larger sized sets of frames and require 
considerably more RAM.  Next, choose a frame rate.  We recommend “24 frames per second”.  24 fps is 
used in film, 25 fps is used for PAL (Europe) video and 29.97 for NTSC (US/Canada) video.  15 fps is often 
adequate for displaying video on the web.  The lower the frame rate, the smaller is the size of the file that is 
stored.  This is something to consider.  A 2-minute movie can require over 100 MB of RAM when saved in 
fast and larger frame rates.  

 
77) Click “SAVE”.  Another menu will appear, asking if you wish to save the file compressed or uncompressed.  

A compressed file requires less disk space than an uncompressed file, but may not look as good when played 
back, and the process of compressing video can dramatically slow down Celestia.  Celestia is set to save 
movie files uncompressed.  To save a compressed file, choose the format you desire.  You may wish to try 
different choices and determine which one works best for your computer.  The free DivX video codec 
available from www.divx.com provides excellent compression and quality, and is quite fast.  If you want to 
create many video files with Celestia and are concerned with file size, we recommend you download and 
install DivX onto your computer, then save your videos as a compressed DivX file.    

 
78) Click “OK”   A red box will now appear on your screen.  You can move what is in that box by clicking on the 

screen with your standard movement keys.  When ready to start taping your movie, start time moving forward 
if it was paused (press [spacebar] again), and press the [F11] key on the keyboard.  Recording will begin.  To 
stop, press the [F12] key.  The recording will stop and the red box will disappear.  Your movie is saved.  To 
cancel a movie at any time, simply press the [F12] key. 

 
 
 Save Location (BOOKMARKS)   

79) To save a particular location, simply set up your position and time as you would like it, pull down the 
Bookmarks Menu and choose Add Bookmarks.  Type a name and click OK.  Celestia will save a positional 
and time bookmark in its database.  To return to that location at the exact time you saved, simply click on the 
Bookmarks Menu again whenever you wish, choose a saved location from the list and you will go there 
instantly.  To delete a location, rearrange the list or otherwise organize them, use the Organize Bookmarks 
option in the pulldown menu.  The Location/Bookmarks feature is very handy to have and use.  For example, 
if you have taken some time to position yourself in a particularly good view location in space or at the 
beginning of a celestial event, save that position with a bookmark and you can come back to it or show others 
the same event by an instant click on the bookmark. 

 
 
 

 Cel://URLs 
 

80) Celestia makes it possible to share locations and export them out of the program by inserting them in a web 
page or other document, through cel://URLs.  A cel://URL is a string of text (a hyperlink) that contains your 
current ship location, orientation, time, render options and field of view.  With it, you can take a snapshot of 
your precise position, time and view in space, and save it as an external hyperlink (a URL).  If you then paste 
that text string into a document that recognizes hyperlinks (word processors, web browsers, notepads, etc.), a 
user clicking on that link will automatically launch their own copy of Celestia and be taken to the exact 
position in space that you were viewing.  It can be used anywhere you would use an http hyperlink.  
Obviously, the user must have Celestia on their computer for this feature to work.  For example, cel://urls 
have been used extensively in this document to take you to different locations associated with the figures.  
Another example below is a cel://url that captures the position of Phobos, one of Mar’s moons, orbiting high 
above the planet in January 2000.  Click on the link below, and you will be taken to that exact position, time 
and place in Celestia. 

http://www.divx.com/
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              Click here for a ticket to Mars
 
 
Figure 32 – image captured via 
cel://URL 
 
 
 

 

 
 
 
81) Please note that cel://URLs are hyperlinks.  You should only click on them once (single-click, not double-

click).  In fact, if you click one twice, it will launch two copies of Celestia at once.  Since Celestia uses a 
great deal of computer memory, two running programs could lock up your computer.  If everything seems to 
stop or slow down after using a cel://URL hyperlink, or if the screen view does strange things, you probably 
clicked it twice.  Close one or both of the Celestia programs, reclick just once, and things should improve.   

 
82) To save your position in Celestia as a hyperlink, you can use the Bookmarks menu mentioned earlier.  You 

can also press either [Ctrl+C] or [Ctrl+INS].  This will save the hyperlink to your computer clipboard.  To 
paste that link into a web browser, simply position your cursor in the address field at the top of the browser 
and press [Ctrl+V].  To paste the link into a text document or a PowerPoint presentation, you may be able to 
simply paste the link by positioning the cursor on the page and pressing “Paste” from the toolbar menu, or 
[Ctrl+V] from the keyboard.  If successful, the link will paste into your document and change color when you 
hit the Enter key.  Clicking on it will launch Celestia.  If that doesn’t work, you may have to paste the link by 
“inserting a hyperlink”.  See your application software for directions on how to do that.  You can also link a 
Cel://URL to an image.  For example, right-clicking on graphic images in word processing and presentation 
software will usually offer you the option to insert a hyperlink.  If you select it, paste the Cel://URL into the 
hyperlink address.  Clicking on the picture itself will then launch Celestia.  To see this in action, return to 
figure 32 above and this time, click once on the image, not on the text above it.  You will be taken to Mars. 

 
83) As evidenced in this document, Cel://URLs are ideal for showing others a particular discovery or position 

made in the world of Celestia.  For example, perhaps you’ve positioned yourself to witness the passing of a 
Near-Earth asteroid as it whizzes past Earth, or have assumed a position off the North Pole of the Sun with 
orbits selected and the entire solar system orbiting below you.  Saving that location to a cel://URL and pasting 
it on the web or in an e-mail for others to activate is an ideal way to share your Celestia experience.  You’ll 
find cel:// URLs also used frequently in the Celestia forum. 

 
84) Note:  Be careful using cel:// URLs with add-ons.  If you save the camera position near a body that is part of 

an add-on you previously installed, someone who later clicks on the URL will likely see a very dull view of 
empty space unless they also have the same add-on installed. 

 
Also please note:  When you click a cel://url, Celestia must reset your View Options to match the cel://url 
commands (the same as in scripts).  When you are done visiting the location or enjoying the view that the 
cel://url brought you to, there is no quick reset command to return your view settings to the way you had 
them before.  You will have to open the Render menu and make sure the check boxes you desire are again 
selected.  Alternatively, you can choose all of the options you desire and create your own cel:url hyperlink 
as a Bookmark.  Call it “Reset”.  Then, if someone else’s cel:/url resets your program to settings you do not 
want, simply click on the bookmark and Celestia will reset your parameters and take you to that location.   
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Multiview   (VIEW MENU)  
  

85) Celestia can also show you views from different camera positions simultaneously.  This can be very helpful 
for visualizing phenomena like eclipses, where you want to watch a view from the Sun, the eclipsed planet or 
moon, and the occluding body all at the same time.  Planetary encounters by spacecraft are another category 
of events where multiple views can be illuminating. 

 
86) When multiple views are enabled, one of the views is the active view and is marked by a thin highlighting 

frame around it.  All Movement commands will affect just the active view.  Other commands such as setting 
the time or date or Render menu commands are global, affecting all views.  New views are created through 
the keyboard commands of [Ctrl+U] and [Ctrl+R].  [Ctrl+U] splits the active view horizontally, leaving two 
identical views side by side.  Pressing [Ctrl+R] performs a vertical split that gives two vertically stacked 
views.  A newly created view can be further split by pressing [Ctrl+U] or [Ctrl+R] again; you can continue 
this until the views become impractically small.  The [TAB] key is used to cycle the active view.  A view that 
is no longer required may be removed by pressing the Delete [DEL] key.  [Ctrl+D] will delete all views 
except the currently active view.  

 
87) Views can also be created and deleted with the 

View menu.  The View menu also contains 
two additional options not available via a 
keyboard command.  When checked, Show 
frames puts a frame around each Multiview.  
The other View menu setting is synchronize 
time.  Ordinarily, time is synchronized 
between all views, but if you deselect time 
synchronization, you can set the current time 
in each view independently by clicking within 
the view frame and using the Time menu to 
change the date or time.  Turning time 
synchronization back on resets the time in all 
views to that of the active view.  Note that the 
time rate cannot be set per-view; the rate 
commands and pause affect every view. 
            Figure 33 –Four Celestia Multiviews seen at once 

 
 

Other Documentation Available 
 

This concludes the general User’s Guide to operating elestia.  The Celestia community, however, has also  C
prepared a variety of other tutorial and manuals that teach you what image files are, how Celestia loads and uses 
them, and how data files of various kinds are used to instruct Celestia in what to do and where to do it.  Look for 
them under the Documentation link at http://www.celestiamotherlode.net    One of our forum members, Don 
Goyette, has also written a comprehensive guide that will teach you how to create scripts, which are a series of 
lists that Celestia follows one at a time to take a space journey.  For example, you can design a script to open 
Celestia orbiting a Red Giant star thousands of light years away.  Then as you watch, your spacecraft will 
accelerate and fly back to Earth at warp speed.  You can also insert text messages for the viewer to read.  It is an 
excellent tutorial on how to develop scripts.  You can find it and download it in a variety of formats on his 
website at SCRIPT GUIDE.   
 
 

http://www.celestiamotherlode.net/
http://www.donandcarla.com/Celestia/


Celestia User’s Guide              37 of 40 

Credits 
 

This User’s Guide was written by Frank Gregorio, a high school teacher in Manassas, VA..   

ersion 1.3.2 
ugust, 2004 - Frank Gregorio 

elestia – courtesy of : 
urel 

d 

ermission is granted to copy and distribute this document under the terms of the GNU Free Documentation License, Version 1.1 or any 

 
V
Copyright © A
 
C
Developers:  Chris La
  Clint Weisbro
  Fridger Schrempp 
  Bob Ippolito 
  Christophe Teyssier 
  Deon Ramsey  
Copyright © 2000, 2004 - Chris Laurel 
 
 
P
later version published by the Free Software Foundation; with no Invariant Sections, with no Front-Cover Texts, and with no Back-Cover 
Texts.  A copy of the license is included in  "GNU Free Documentation License". 
 
 

 
See Keyboard summary on next page 

http://teyssier.nerim.net/celestia/doc/common/gpl-license.html
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Celestia Keyboard and Mouse Command Summary 
(Print these two pages as a convenient keystroke summary) 

This command summary can also be accessed within Celestia.  Simply pull down the Help menu and click on “Controls”. 
 
Mouse Functions: 
Left – click on object:  select object 
Right drag:   orbit the selected object in any direction 
Left drag:   orient scene in any direction 
Rotate Mouse Wheel:  adjust distance to selection 
Right + Left drag:     adjust distance to selection 
Ctrl + Left drag:      adjust distance to selection 
Shift + Left drag:     change field of view (FOV) (e.g. => telescopic view) 
Wheel (middle button) click:  toggle field of view between 45 degrees and the previous field (e.g. telescopic view) 
Left double click      center selection 
Right - click          bring up context/select menu 
 
Render Functions - Keyboard: 

R Decrease texture resolution 
Shift+R Increase texture resolution 
P Toggle (turns on or off) planet labels 
M Toggle moon labels 
E Toggle galaxy labels 
B    Toggle star labels 
W Toggle asteroid and comet labels 
N    Toggle spacecraft labels 
=    Toggle constellation labels 
& Toggle Location labels 
V    Toggle info text  
U    Toggle galaxy rendering  
O    Toggle planet orbits  
I    Toggle clouds  
;   Toggle Celestial grid (Earth-based equatorial coordinate sphere) 
/    Toggle constellation diagrams  
Ctrl+A  Toggle atmospheres 
Ctrl+B  Toggle constellation boundaries 
Ctrl+E Toggle eclipse shadows 
Ctrl+L  Toggle nightside lights 
Ctrl+S  Toggle stars as points, discs or fuzzy points 
Ctrl+T Toggle comet tails 
Ctrl+V Cycle through vertex shading options 
Ctrl+W Toggle wireframe mode (displays objects as wireframe models) 
Ctrl+X Toggle antialias lines mode 
Ctrl+Y  Toggle autoMag = auto adaptation of star visibility to field of view  
[  If autoMag OFF: Decrease magnitude (fewer stars visible) 
 If autoMag ON: Decrease magnitude at 45 deg field of view  
]   If autoMag OFF: Increase magnitude (more stars visible) 
 If autoMag ON: Increase magnitude at 45 deg field of view  
Shift +  {  Decrease ambient light 
Shift +  }  Increase ambient light 
Alt+Enter Toggle full screen display mode on or off   
 
Navigation Functions - Keyboard: 

H     Select the Sun (Home) 
C Center on selected object 
G Goto selected object 
Ctrl+G Goto surface of the object 
F Follow selected object 
ENTER Select a star or planet by typing its name, then press Enter again 
Y Orbit the selected object at a rate synchronized to its rotation 
. Increase Field Of View (FOV) 
, Decrease Field of View (FOV) 
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Shift + : Lock on selected object.  Point at 2nd object and press again to pair the two. 
Shift + " Chase selected object (orientation is based on selection's velocity) 
T Track selected object (keep selected object centered in view) 
HOME Move closer to object 
END Move farther from object 
Up arrow Your view pitches downward (also see # 8 key on numerical keypad) 
Down arrow Your view pitches upward (also see # 2 key on numerical keypad) 
Left arrow Your view rolls counter-clockwise (also see # 7 key on numerical keypad) 
Right arrow Your view rolls clockwise (also see # 9 on numerical keypad) 
# 4 number key on numerical keypad - Your view yaws (swings) to the left 
# 6 number key on numerical keypad - Your view yaws to the right 
# 5 number key on numerical keypad – instantly stops yaw, pitch or roll 
Shift+arrow keys Orbit around the object automatically 
Shift + * Look back view (rear view) 
1-9 Select planets around nearby Sun 
Esc Cancel hold on object, cancel command or script action 
Backspace Cancel current selection 
 

Time Functions - Keyboard: 

Spacebar Stop or pause time (or if paused, resume time) 
L   Time 10x faster (repeat for faster time)  
K   Time 10x slower (repeat for slower time) 
J   Reverse time (it flows backward) 
 \ Return to Real Time 
Shift + ! Set time to the current clock time 
Shift + ? Display light-travel delay between observer and selected object 
- Subtract light-travel delay from current simulation time (toggle on or off) 
 
Joystick Functions – typical  (Note:  joystick buttons differ in function – experiment with yours): 

F8  Enable joystick (press again to disable) 
X axis  yaw 
Y axis  pitch 
L trigger roll left     (button C on a Microsoft Sidewinder Pro) 
R trigger    roll right     (button D) 
Button 1     slower     (trigger on Microsoft Sidewinder Pro) 
Button 2 faster      (thumb button on Sidewinder Pro) 
 
Multiview Functions - Keyboard: 
Ctrl+R  Split view vertically 
Ctrl+U Split view horizontally 
TAB Cycle active view 
DEL Delete active view 
Ctrl+D Delete all views except active one 
 
Spaceship commands - Keyboard: 
A Increase velocity 
Z Decrease velocity 
Q Reverse direction 
X Set movement direction toward center of screen 
S or F1 Stop 
F2 Set velocity to 1 km/s  
F3 Set velocity to 1,000 km/s 
F4 Set velocity to speed of light 
F5 Set velocity to 10x the speed of light. 
F6 Set velocity to 1 AU/s 
F7 Set velocity to 1 ly/s 
 
Other commands - Keyboard: 
D  Run demo 
F10  Capture image to file 
F11 and F12  Start and stop Movie Save 
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Ctrl+INS or Ctrl+C Copy location URL to clipboard (Windows) 


	Note:  make -install will need to be run as root unless you'
	The Opening Screen

